VideoWinks

Create, produce and direct your own animations, even if you can't sketch.

For the Apple Macintosh.” I | 'n‘ ‘ ll 5 h I

Developed by MacroMind” Inc SO FTWARE



MacroMind, Inc.

™



Apple Computer, Inc. makes no werranties, either expressed or implied, regarding
the enclosed computer software package, its merchantability, or its fitness for
any particular purpose.

Limited Warranty. If during the first 90 deys from purchase the disk is found
to be defective, return the disk to Hayden for & free replecement. After 90 day
send your disk and $10.00 for replacement. To obtein this warranty you must
complete and return the enclosed registretion card.

Meither Hayden Software Company nor the suthor(s) of this program are liable
or responsible to the purchaser or user for loss or damage caused, or alleged to
be caused, directly or indirectly by the softwere and its sttendant documenta-
tion, including {but not limited to) interruption of service, loss of business,
or anticipatory profits.

YideoWorks™ is a tredemark of MecroMind, Inc. licensed exclusively to
Hayden Software Company, Inc.

Copyright {c) 1985, MacroMind, Inc.

Published by Hayden Software Company, Inc.

ATl rights reserved.

Warning: This reservation covers art shown by this software as well a3 the
software itself. Purchasers of copies of this software may view and reproduce
such art for non-commercial enjoyment purposes only.

Macintosh™, MacWrite™, and MacPaint™ are trademarks of Apple
Computer, Inc.

Art Grabber™ snd Body Shop™ are trademarks of MacroMind, Inc. licensed
to Hayden Software Company, Inc.

Ensemble™ is & trademark of Hayden Softwere Company, Inc.

HAYDEN SOFTWARE COMPANY, INC.

600 Suffolk Street
Lowell, MA 01854
1-800-343-1218

(in MA call 617-937-0200)



TABLE OF CONTENTS

................................... 1
GELTTIEREERINTED . .....cccccncasdinsensssessnssas 3
ORI .. i ke 3
o RN A~ T P TR o 3
Hardware Requirements ............coeivvneenn. 4
BT R e e DA e . 4
L R e TR SO G R 5
Eadweard Muybridge - Reverse Animator .......... 5
Cinematography - TheHardWay .................. 6
P Y L e s i e e e 7
o g AR |y < S R 8
SO RN B oo st T B R i h v s i s 9
SR i N R e e e 9
KORREY TR ; ox v v 55505+ nnanses rREReRNES x e ses s 11
T OO < e R 11
YO TN oo cdith e A e s 12
Creating the First Castmember .................. 12
Creating the Second Castmember ................ 14
Moving Between Castmembers ................... 15
Lo EE o Lo 15
Frame by Frame Animation ..................... 17
Tweak - the Incremental Motion Generator ........ 18
A Brief IntroductiontoSprites ..............c.... 19
Who's On First? An Introduction to Foreground
PR 55 5o s wr o AR R A A 21
What's the Score? An Introduction to Editing . .. ... 23
AT YO PUINI: . :ovoivsvssinsasssanaissns 27
TCHhaROPE T .. .. ciccosrssassnnnsonnas 28
PHAROAH'SPLAGUE ...............covvivuvuennes 31
L eg L MNP e S R G 32
GoFordhandMultiply ......:........ccccc0i000s 34
DRIVENAROUNDTHEBEND ....................... 43
i L RO e R RS e s 43
L g R R 50
I s i v s wwn R . 52
THEVIDEOWORKSPROCESS ...................... 55
R INEENIN . . oo oins onmaiiiem s s sen sus 55
e e e K P N GO 57
Fp 0 n o R e R e D R 62
Grabbing with AtGrabber ...................... 63
SRR BB . i v e s 67

Radl TINMeADINAHON . .....cccovcosrsnsnanenssss 68



HINTS, TIPS AND CAVEATS . ......ovvvinanennnn. 71

e R TRt o U SO e B D 75
TIN5 sl vt L S e nnn s m S i
TROCHERE M ... v linh v evsiiws s 76
THEPREMERE . e s T n s e e 77
8 L 5T T R i (L L 79
RO MR .. sibbaa et aoniiie 81
The WINdOws MO .......cvieesssesesacsanssss . 85
T D s o s il e v v s mpsm o m o m 97
TheFontandthe StyleMenus .................... 98
By 7w e R LR L TR e R S e 99
TORERERIIINE. it S b w50 w9 o 102
VideoWorks Memory Allocation ............ ..... 105

h T e | 1 L 8 T P R e 107

s SRR S L 5 L S SR 111

T L oo i SN ke - 113

Cow o R PTSOR | Vhl Th . e e e i 131



INTRODUCTION

You no longer have to be a programmer to create high quality
computer animation. With VideoWorks™, the first
full-featured animation package for the Macintosh™, you can
produce professional quality animation even if you don't know
the difference between a sprite and a pixel. Just as the
Macintosh has become "the computer for the rest of us”,
VideoWorks will become the animation package for the rest of
us, making it easy and fun to create animations without any
programming experience whatsoever.

With VideoWorks, you can create your own images for
subsequent animation, or borrow ("grab”) from a vast library of
images created by a professional artist. Once you have created
or chosen your images, VideoWorks gives you two ways to
animate them: by real time recording of the mouse movement,
or frame by frame shots of the image as they move or change.

VideoWorks' features include:

*  Two methods of animation: real time recording and frame

by frame

* As many as 24 different objects on the screen at the same
time - all of which can be animated

* A graphics tool for creating original artwork to include in
animations

* A Movies Disk packed with examples to show you what
VideoWorks is capable of creating

* An Art Disk full of predrawn images to incorporate in your
own animations

* Art Grabber™, a unique tool that allows you to move
existing art from any MacPaint™ document onto your easel
for subsequent animation

* A sound generator to create a complete range of sound
effects to add to your animations

* Easily implemented special visual effects;

* Simple to use editing systems

* Speed adjustment even during playback






@? J{\_lg/ﬂ GETTING STARTED

How to Use
This Manual

The VideoWorks manual is designed to let you dive right in
without wading through a lot of animation principles. Such
information is made available to the interested reader,
however, in "Foreground”, a kind of Foreword containing
background material of a general and historical nature. Those
anxious to get started may skip that section and go straight to
"A Guided Tour", an introduction to VideoWorks through
demonstrations and simple exercises. VideoWorks' advanced
techniques are covered by a series of three tutorials
("Pharaoh's Plague”, "Driven Around the Bend", and "The
VideoWorks Process") designed to make you an expert animator.
The remainder of the manual consists of "Hints, Tips and
Caveats", "VideoWorks Reference" (a guide to all the menu
options), a "Glossary" of animation terms, and a select
"Bibliography" to further your study of computer animation.
Finally, as a reference, all of the art contained on the Art Disk
is reproduced in the back of the manual.

The Software

Your VideoWorks animation package consists of three disks:
the main program disk, labeled VideoWorks, which contains
everything you need to create your own animations; a
demonstration disk, labeled Movies, with examples of the
kinds of effects you will be able to create with just a little
practice; and an artwork disk, labeled Art Disk, containing
"canned" images that you can use in your own animations.

So that you may concentrate on learning how to create your
own animations, VideoWorks has incorporated the standard
Macintosh User Interface. The way you use your mouse, pull
down menus, scroll bars and select are all just like MacWrite™
and MacPaint. VideoWorks even has Cut, Copy and Paste. If
you need to refresh your memory on certain features and
techniques, refer to Macintosh , your user's guide.



Hardware
Requirements

To run VideoWorks, you will need a Macintosh with at least
128K. Although VideoWorks will work satisfactorily with just
the Macintosh's internal drive, a second (external) drive will
help avoid a lot of disk swapping, especially if you intend to
use the canned artwork on the Art Disk. Nevertheless, for the
purposes of this manual, we will assume that you are operating
with the Macintosh's internal drive only, and will advise you
accordingly. If you have an external drive, we assume that you
already know how to use it.

Before You
Begin

VideoWorks comes with one set of master disks. Make at least
one copy of these disks. Save the originals is a safe place and
use the copies. This protects against accidental damage to
your master disks. If you are unsure of the procedures to make
a disk copy, consult Macintosh, your user's guide.

When you start VideoWorks with a backup disk, you will be
asked to insert your original master disk in the internal drive
for verification. You can also put VideoWorks on a hard disk.
You will be asked to insert your original master disk in the
internal drive when you start VideoWorks.



FOREGROUND

Through the magic of animation, a series of discrete, static
images appears alive and in motion. The physiological basis
for this phenomenon, known as persistence of vision, was
well known to the pioneers of animation, the creators of such
devices as the zoetrope (literally, "towards life") and the
phenakistoscope. These devices, which were little more than
parlor toys when they were first introduced in the 1830's and
40's, made it possible to present a number of images to the
eye in rapid succession without blurring the individual images.
The zoetrope did this by means of vertical slits placed at
regular intervals around a rotating drum. The viewer would be
able to see the images through the slits as the drum rotated, a
technique which "froze" each image long enough for it to
register in the brain. The rest was up to the persistence of
vision, which caused the images to merge together to create
the illusion of continuous motion.

The phenakistoscope employed a similar technique, but used a
rotating disk instead of a drum. The viewer could look through
the slits in the disk at a mirror, which reflected the images on
the backside of the disk. As with the slits in the zoetrope, the
slits in the disks were a primitive form of shutter, effectively
freezing the motion of the individual images.

Eadweard Muybridge -
Reverse Animator

In late 1800's, Eadweard Muybridge produced thousands of still
photographs depicting human and animal locomotion. In doing
s0, he made significant contributions to both cinematography
and animation. That he has not always been recognized as a
pioneer in those fields may be because his contribution was
somehow backward: while others were trying to create the
illusion of motion from static images, Muybridge was doing the
exact opposite, creating static images of moving things. Thus,
Muybridge might be regarded as a "reverse animator”,
something like a reverse engineer of locomotion.



Muybridge began his experiments under the patronage of Leland
Stanford, Governor of California and wealthy breeder of
racehorses. Stanford had commissioned Muybridge to
photograph his horse Occident in motion, presumably to settle a
dispute whether a trotting horse ever has all four feet off the
ground at the same time. Muybridge took a number of still
photographs, one of which showed Occident with all four feet
off the ground, thus settling the long-standing controversy.

Stanford, however, was not to be satisfied with merely

settling disputes. As a breeder of racehorses, he wanted to
develop a theory of locomotion, so he could better select and
train his animals. He proposed, therefore, that Muybridge take
sequential photographs of horses in motion, a fraction of a
second apart. Stanford was to provide financing, and
Muybridge the knowhow for the project.

Cinematography -
The Hard Way

The nonexistence of cinematographic equipment did not stop
Muybridge, who used banks of still cameras placed 21 inches
apart and triggered by trip wires. Using this technique, he
could photograph a horse as it galloped past the cameras,
capturing each moment of time onto a separate photographic
plate.



Muybridge's experiments did not end with horses, however.
Over the next twenty years, through the turn of the century, he
photographed people, birds, dogs, cats and dozens of other
animals in motion, using the same technique. To show his
photographs, Muybridge developed a device he called the
zoopraxiscope, a variation of the phenakistoscope which could
project the images onto a wall. Thus Muybridge found a way of
reviving the motion that he had previously stilled. Although
cumbersome and limited in scope (compare his 24 large-format
cameras with trip wires to today’s portable movie cameras),
Muybridge had nonetheless developed a working method of
capturing, storing and replaying something as fleeting as
motion.
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Film Animation

While Muybridge was struggling under the weight of his 24
cameras and his zoopraxiscope, Thomas Edison and others were
putting the finishing touches on various "motion picture
devices", cameras capable of capturing a series of images on
continuous strips of film instead of individual glass plates.
George Eastman had already developed flexible celluloid film
which could be wound onto spools in 50 foot lengths or more,
and with Edison's claw escapement mechanism (which held the
film still long enough to capture an image), the film industry
was up and running. Interestingly, from the animator's point of
view, the most important invention wasn't the movie camera
with its ability to take a number of stills in rapid succession,

but rather the development of flexible strip film and the
projector for playing it back. In fact, early motion picture
cameras were even detrimental to animation, since most were
incapable of shooting one frame at a time, a necessary feature
for animating artwork.



Fine Tuning

With flexible strip film and motion picture projectors, the

film animation industry needed nothing but fine tuning and
refinement. This it received in the hands of John Bray and Earl
Hurd, who in 1913 were the first animators to use celluloid
sheets, or "cels". Before Bray and Hurd, animation was a
laborious process involving the creation of thousands of
individual frames from scratch. Everything had to be drawn
again and again, including parts of the image that didn't change
from one frame to the next, such as the background scenery.
With cel animation, each background scene needed to be drawn
only once on plain opaque stock. The moving parts, on the other
hand, were drawn on the transparent cels and overlayed on top
of the background. The cels themselves could be overlayed on
top of each other, so that different parts of the same character
could be animated separately.

The savings in time and labor were significant, and Bray and
Hurd's little studio on 42nd Street in New York flourished. Even
so, however, the time and labor involved in creating a one-hour
animation was still enormous. Considering that motion picture
film was at that time projected at the rate of 18 frames per
second, a one-hour animation would require as many as 64,800
individual frames, a monumental undertaking for even a small
army of artists. And when the projection rate for motion

picture film was subsequently standardized at 24 frames per
second (to accommodate the sound track), the number of frames
for a one-hour animation increased to 86,400, a change which
most animators must have felt was in the wrong direction.




The Disney Era

By the time Walt Disney entered the picture in the 1920's, the
basic techniques of animation had already been well
established: all that was needed was fine tuning and polishing.
This is not to say, however, that Disney's contributions to
animation were in any way insignificant. On the contrary,
Disney took a fledgling medium and developed it to a level still
unexcelled today. His Snow White and the Seven Dwarfs
(1937), for example, remains a standard, even as it approaches
its 50th anniversary. Along the way, Disney introduced
numerous technical refinements, such as multi-layered
background cels which moved across the field of vision at
different rates, and thereby heightened the illusion of depth. In
addition, Disney provided greater realism in character
movement by making use of scientific studies of human and
animal locomotion. Indeed, Disney's main source of information
about locomotion was none other than EadWeard Muybridge
himself, the "reverse animator" who had taken motion and
broken it down into static images.

The Computer Era

It was only a matter of time before the information stored on a
strip of film could be broken down and stored as bits, the basic
unit of information and the basis of all digital computing. A bit
(for binary digif) is like an on-off switch, and provides
information as to which of two possible states prevails. Any
information, whether complex mathematical relationships or
graphic images, can be expressed in bits and stored as binary
code. In computer graphics (the precursor to computer
animation), a screen image is composed of an array of binary
dots (known as pixels, for picture glements), each of which
resides at a specific location on the screen and is either on or
off at any given moment. Because every pixel on the screen
corresponds to a bit of information residing in the computer's
memory, this screen image is known as a bit map.

Computer animation is simply computer graphics with the
addition of the dimension of time. With animation, the bit map
changes many times a second, in accordance with instructions
residing in another part of the computer's memory. Obviously,
then, the computer must be capable of handling a number of
different tasks at the same time.

9



Until recently, computer animation was in the exclusive domain
of the large, powerful and very costly mainframe computers,
and was restricted to specialized situations, such as flight
simulators. Even though traditional animation technigues were
(and are) labor-intensive and hence costly, they were still
cheaper than their computerized counterparts, some of which
cost thousands of dollars a minute to operate.

A crossover of sorts occurred in the late 1970's. As the cost of
computer time dropped, it became more feasible economically
to have computers generate animated sequences than to produce
them by hand. The result was animated sequences in films such
as Star Wars, TRON and Star Trek Il - The Wrath of Khan. Since
then, computer animation has become the primary method of
generating the graphics for television network logos,

newscasts, sports results, and maps and graphs.

As computer memory continues to drop in price, and as
software becomes more sophisticated, computers may well
become the exclusive tools for creating animations, making the
old hand-drawn methods as much a part of history as the
zoopraxiscope. Today, with high speed and high resolution
personal computers such as the Macintosh, and with
sophisticated animation software such as VideoWorks, anyone
who can click and drag a mouse can create professional quality
animations in less time than it would take to draw a

storyboard.
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GUIDED TOUR

At the
Movies

Before you set out to create your own animations, you will
naturally want to see just what VideoWorks and your Macintosh
can do. For this reason, we have included a demonstration disk
with examples that you can sit back and watch, or use as a
basis for your own creations. For the moment, let's sit back
and watch the show. Just follow these simple steps:

L

Turn On your Macintosh.

When you see the disk icon with a flashing question mark,
insert the disk labeled "VideoWorks".

The drive will whir for a few moments and then stop. At
this point, the Macintosh desk top will be displayed. If you
are not using an external drive, select Eject from the File
menu and then insert the disk labeled "Movies" into the
internal drive.

When the drive stops whirring, double-click the file "Demo”
to Open, or select the file and Open from the File menu.

x

DEMO

Once the various VideoWorks windows have appeared,
select Demo from the File menu. That's it! Now sit back
and enjoy the show.

You can stop the animations anytime by moving the pointer to
the top of the screen and holding the mouse button down. When
you do that, you'll notice that the menu bar reappears (it had
never really gone; it was just hiding behind the "Stage").

While holding the mouse button down, move the pointer 1o
the File menu and then select Quit. In a few moments you
will find yourself back at the desktop.

Pull down the File menu once more, Eject the "Movies”
disk, and insert your "VideoWorks" disk. Now the stage is
set for your creative endeavors.

11



Your Turn

to Play
You've seen what VideoWorks is capable of doing on the
Macintosh; now let's see what you can do.

* If you haven't already done so, double-click the VideoWorks
icon (the video camera), or select VideoWorks and Open
from the File menu.

|4,

Video'Works

Wait a few seconds as the program loads into memory, and
then take a close look at the screen. What you will see is
the main VideoWorks screen, consisting of two windows: the
Cast and the Control Panel (located at top right), as well

as the menu bar along the top of the screen.

* Pull down the Windows menu and select CheapPaint.

Briefly, the animation process follows this general procedure:
each separate image (or "castmember”) is created in a
CheapPaint easel, and is then transferred to the Cast window
(automatically, as you will see). Individual castmembers are
then dragged out onto the Stage, where they are animated
using either real time or frame-by-frame recording. Once the
animation has been created, it can be played back, rewound, or
advanced one frame at a time using the controls on the Control
Panel.

Creating the
First Castmember

At the top left corner of the CheapPaint window you will notice

a small white square bounded by heavy black lines. This is your
easel (or canvas), on which you will be creating your
castmembers. Like the CheapPaint window itself, the easel is
resizable: by pointing to the easel's "handle" at its bottom

right and holding the mouse button down, you can make the
easel as large or as small as you need it, just by dragging the
handle diagonally up or down the screen.

12



pencil rectangle

fat peaint
new bits brush

QLW v e

In addition, you can relocate the easel. By pointing to the heavy
bar at the top of the easel and holding the mouse button down,
you can drag it anywhere you wish within the confines of the
CheapPaint window.

Along the top of the CheapPaint window you will notice a
number of icons. These are the main graphics tools, similar to
MacPaint but without the variety (hence "CheapPaint”). We will
be using some of these tools to create our Castmembers.

* Click the circle.
* Before we draw any circles, however, let's select a fill
pattern. Pull down the Draw menu and select a pattern by

clicking one of the boxes (anything except black, because we
will be using that later in this tour).

13



Now let's go back to CheapPaint. Move the pointer into the
easel, and waltch it tumn into a crosshair. Move the crosshair
to one of the corners of the easel (say, the top left) and,
holding the mouse button down, drag it diagonally towards
the opposite corner. A circle is born, filled with your
selected pattern.

Before you do anything else, take a look at the Cast window
at the bottom of the screen. Note that the first (leftmost)

cell has a heavy black border around it, unlike the other
cells in that window. This indicates that that cell is the

one selected, and that when you have finished creating your
image, that's where it will go.

Untitled Cast

Creating the

Second Castmember

-

When you are satisfied with the image you have created in
the easel (for now let's pretend that the circle with the
pattern fill is just what you wanted), click the first

(leftmost) CheapPaint icon, the one that looks like a
miniature easel. Note that when you did so, a new easel
appeared. Note also that the black border that used to be
around the first cell in the Cast window is now around the
second cell, indicating that you are now working on the
second castmember (or, as you will see later, that the
second castmember is currently "active”).

Let's draw our second castmember. Pull down the Draw
menu and select the black fill.

14



Go back to CheapPaint and click the rectangle. Before we
put a black square into the new easel, however, let's make
the easel a little bigger by dragging its handle diagonally
down and across the screen until it's about two or three
times as big as the first easel.

Move the crosshair to a point near the top left-hand corner
of the easel, and, holding the mouse button down, drag it
diagonally toward the bottom right hand corner. As soon as
you release the mouse button, you will see that you have
created a black square, your second castmember.

Moving between
Castmembers

If you need to go back to the first easel, just move the pointer

to any part of it and click. This activates the easel as well as
the corresponding cell in the Cast window. Even if you have the
maximum 64 easels in the CheapPaint window (or 256 on a
Macintosh with 512K), you can activate any one of them just by
clicking it. And if the easel you want happens to be buried
under other easels, just move them aside until you find it, or, if
you know which Cast cell it's in, simply click that cell in the

Cast window.

Real Time
Recording

Try it now. First, activate the Cast window by clicking
anywhere on it. Now click the first cell in the Cast window,
and you'll see that the corresponding easel is
simultaneously activated in CheapPaint. This is one of the
ways that VideoWorks makes life easy for you, by
coordinating the windows you are using.

Now, let's animate the circle using real time recording.

First, Close the CheapPaint window by clicking the Close
Box at the top left (you may need to activate the CheapPaint
window first by clicking anywhere in the CheapPaint
window).

To record in real time, first select the castmember you
wish to animate (the circle in this particular instance).

15



* Click the Play button on the Control Panel.

* While holding the mouse button down, move the pointer
around the stage for a while, and then release.

back step
rewind step stop | play uddenal

Panel
- channel

indicator
_I spaed I ]
t!:h J control

sound speed frame range
switch indicator indicator 1ndicutﬂrs

You will find, first of all, that the circle (the selected
castmember) appeared on the stage the moment you pressed the
mouse button, and, secondly, that as soon as you released the
button, the circle retraced the exact same path that you

created when you dragged it around, in both space and time.

As you watch the circle moving around the screen, experiment
with some of the options on the Control Panel.

* Hit the Stop button and then the Play button.

*  Now hit the Rewind button to wind the film back to the
beginning, and then the Step and Back Step buttons.

* Hit Play again, but this time experiment with the Speed

Control on the second row of the Control Panel, by moving
the slide control.
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Frame by Frame
Animation

MNow let's try a more traditional approach to animation.
* From the Options menu, select BurnScene. This "burns”
the current animation, while preserving the castmembers,
so that you can create a new animation with the same cast.

Drag the circle out and place it near the left hand side of the
screen.

This time, we will be shooting the animation one frame at a
time, a process that involves "adding” or "inserting" a frame
each time. There are three ways of doing this, each of which
produces identical results. First, you can add or insert a frame
by clicking the Add button on the Control Panel. Or, you can
achieve the same result by pressing Command A (holding down
the Command key and pressing the A key at the same time).
Finally, you can add a frame by selecting Add from the Options
menu. The choice is yours, and depends entirely on your
particular application at the time. For example, you might find

it more convenient to press Command A with your left hand
while moving the mouse around with your right hand.

* Let's assume you have decided on this last method for this

exercise, so go ahead and press Command A now. You have
just recorded the first frame of your new animation.

17



* Pick up the circle and drag it to the right the distance of
about one diameter, release it, and then press Command A

again.

* Repeat this five or six times until you reach the middle of
the screen.

* Now hit Play, and watch your circle move across the screen.

Tweak -- the Incremental
Motion Generator

Now that we've almost decided to make a career out of moving
circles around the screen, let's look at a more precise method
of generating increments of motion, as opposed to the manual
method we just used.

*  First, select BurnScene to get a fresh start.

*  Now drag the circle out again and place it on the left side of
the screen.

*  From the Windows menu, select Tweak.

B2 Tweak =
18 X-coordinate
|- = y-coordinate
\_/|

With Tweak you can specify both the direction and the
number of units (measured in Pixels -- see Glossary) that your
castmember will move from one frame to the next.

*  Move the pointer into the main box in the Tweak window
(that's the large box on the left), and click anywhere inside
it.

18



You will notice as you did so that a line appeared, running from
the center of the box to your pointer. This line, which has both
magnitude and direction, is known as a "vector”, and defines
both the distance and the direction that your castmember will
move from one frame to the next. Notice the numbers in the
boxes on the right. The top number refers to right and left
motion, and the bottom number refers to up and down motion.
To implement Tweak, simply click the Do It button each time
you want to move your selected castmember, instead of
dragging it as we did previously.

* Select the magnitude and direction of motion, and then Do
It repeatedly. Your castmember should move across the
screen in the exact increments you specified. Note that Do
It moves the castmember across the screen, but does not
Add a frame to the animation.

Note also that your vector is not limited in magnitude to the
confines of the Tweak box. So long as your initial click is
within the Tweak box, you can drag the line to any point on the
screen before releasing the button. And even though you may
not be able to see the entire line, the upper right boxes in the
Tweak window tell you the coordinates of the end point of the
line.

A Brief Introduction
to Sprites

So far we have been animating one object at a time.
VideoWorks is capable of animating 24 different objects on the
screen at the same time and (this may surprise you) they don't
all have to be circles. Each animated object, is known as a

sprite, and operates in a single channel.

If you look at the right hand side of the Control Panel, you will
notice a matrix of 24 squares. This is the Channel Indicator,
and tells you which of the 24 channels is currently active.

* BurnScene.

* Drag out your first castmember, and it will be assigned to
the first channel. Note that the first square (at top left of
the Channel Indicator) is black, indicating that the first
channel is currently active.

19



*  Now go back to the Cast window and activate your second
castmember, the large black square, and then drag it out to
about the middle of the screen. Alternatively, after
activating your second castmember, you can position it
anywhere on the Stage by selecting Place from the Options
and clicking the mouse button at the desired location.

Note that the second square in the Channel Indicator is now
black while the first square is gray. This means that the first
channel is occupied, but not currently active, while the second
channel is both occupied and active.

If you now drag a second black square out from the Cast
window, you will find that the third square in the Channel
Indicator becomes blackened, while the first two are gray.

This also illustrates that it's possible for a single castmember
to occupy more than one channel (or, to use alternative
terminology, to be more than one sprite) at a time. Each of the
two squares on the screen is now a separate sprite and can be
animated independently of the other.

20




Who's On First?
An Introduction to
Foreground Prioritizing

When there is more than one sprite on the Stage, VideoWorks
needs to know which one will be considered foreground and
which one will be considered background. In other words, when
two sprites cross on the screen, VideoWorks needs to know
which one will move in front of the other. This is known as
foreground prioritizing, and, although it is an important

concept in animation, it is handled by VideoWorks with
characteristic simplicity.

Here is the rule: Sprites in later channels (those toward the
end of the alphabet) will pass in front of (i.e. have a higher
priority than) sprites in earlier channels.

For example, a sprite in Channel B will pass in front of a sprite
in Channel A, while a sprite in Channel C will pass in front of
both A and B, and so on. And because channel letters are
determined by the order in which castmembers are dragged out
onto the Stage, it follows that the castmembers defining
low-priority sprites (i.e., the background sprites) should be
dragged out before those defining high-priority sprites. Let's

try a few examples.

* BurnScene.

* Drag out the first castmember (the circle), and place it
somewhere on the left hand side of the screen.

Notice that the Channel Indicator shows that the first

channel is active. Note also that our circle has a border around
it made up of small squares, indicating that it is the currently
active (or selected) castmember.
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* Drag out the second castmember (the square) and put it in
the middle of the screen.

Note that the border is now around the square, and that the
Channel Indicator shows that the second channel is active. As
you alternately click the circle and the square, you can see that
the Channel Indicator is keeping pace, switching back and forth
between the two occupied channels. This process also works in
reverse: clicking the little squares in the Channel Indicator

has the effect of activating the sprites on the screen.

*  Now, do a frame by frame animation of the circle so that it
moves across the square to the other side of the Stage. You
should know how to do this by now -- if not, go back and
review the section called Frame by Frame Animation.

Did you see what happened when you hit Play? The circle
moved behind the square, because it had lower priority.

Now try it the other way, by moving the square out first (after
burning the scene to get a fresh start). This time, you should
have seen the circle move in front of the square, because this
time the square had lower priority.

You might also have noticed that as the circle moved across the

square, it seemed to have a square “frame” around it. Inthe
next section you will learn how to eliminate this "frame” by
using VideoWorks' matte feature.
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What's the Score?
__An Introduction to Editing

We have just seen how foreground-background priority is
determined by the order in which castmembers are dragged out
onto the Stage. Now let's look at a way of changing the current
priority without burning the scene and starting from scratch.
And we can do this even while the animation is still playing on
g the screen. Here's how:

- *  From the Windows menu, select the Score window, and
take a moment to examine it.

display frame
switches numbers
\ E00===] Untitled Score
channel
letters
playback
head

playback head bar

Down the left hand side of the Score window you can see the

letters A through X. You won't be able to see all of them at

once, but like all good Macintosh windows, the Score window

lets you scroll and resize, so you can focus in on

just the part you need. The letters A through X refer to the 24

o Channels, and the window should show that two of the
channels are currently in use.

The numbers running across the top of the window are the
- Frame Numbers. Although you may only be able to see about
50 frames at the moment, additional frames will be added as
needed.
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If your last animation (the circle moving in front of the square)
is still playing, you should be able to see a small black square
scrolling along the bottom of the Score window. This is your

Playback Head, and indicates your position on the animation.

Now let's take a close look at the two channels we are using.
Because we dragged the square out first, it is occupying
Channel A. Note the row of small octagons (like little stop
signs) displayed on the lower row of Channel A. These indicate
that there were no movements registered for the square, and
that it was stationary for the entire sequence.

Above the row of octagons, you will notice a small square in
the first frame followed by a hyphen. This indicate that after
the first castmember was introduced (in Frame Number 1), no
further castmembers were introduced into this channel. In
other words, these two rows of cells in the first channel tell

us that after the first frame, the square did not change shape,
and it did not move.

If we now look at Channel B, we'll see a different picture: the
two analogous rows in the second channel tell us that even
though the circle did not change shape (i.e., no new
castmembers were introduced), it did move around the screen.
This motion is indicated by the arrows in the lower row. These
arrows are called Relative Motion Indicators, and register
any change in direction by a castmember.

Let's try some basic editing. First, let's eliminate the "frame”
we noticed around the circle as it passed in front of the square.

*  First, position the pointer so that it rests on the first frame
of the circle's channel (Channel B.)
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Select the occupied frames by holding the mouse button
down, and dragging the pointer along the channel until you
reach the first free frame. If you drag too far, keep holding
the mouse button down and back up. Release the button. The
active frames of Channel B should now be blackened,
indicating that these frames have been "selected".

Pull down the Efx menu and select Matte. Notice that the
"frame" disappears as the circle passes in front of the
square. You will get a chance to experiment with the
various Efx options later in the Guided Tour.

Now let's reverse the current foreground priority (so that the
circle will move behind the square once more), and let's try do
do this without even stopping the film. As we learned from the
last exercise, for the circle to move behind the square, it will
need to occupy an earlier (i.e., earlier- lettered) channel than
the square. To do this, we need to move the square's sprite out
of Channel A and into a later channel, say Channel C.

-

Select all of the frames in Channel A. All the occupied
frames of Channel A should now be blackened indicating that
these frames have been "selected".

Select Cut from the Edit menu, which should result in the
disappearance of the selected frames (don't worry, they'll be
back).

Move the pointer to the first frame of Channel C and click
the mouse button. This last click tells VideoWorks that this
is where we will be pasting the cut frames.
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* Select Paste from the Edit menu. The cut frames should
now be visible on Channel C, and when you close the Score
window, you should be able to see the circle moving behind
the square.

Untitled Score

ol _EEEE

This process of selecting a group of frames by dragging the
pointer across them is the basis for most of the editing
techniques that we'll be studying in the three tutorial sections.
VideoWorks lets you select any number of frames in any number
of channels with just a single sweep of the mouse. To select
two channels, for example, drag the pointer across and down
slightly, so that it enters the second channel. By dragging
diagonally in this way, it is possible to select as many

channels as you need with just a single movement.

It is possible to select all the channels with one single
movement just by going to the top of the Score window and
dragging the pointer across the frame numbers. In addition, you

can select an entire channel by double clicking on the channel
letter.

You can cancel any selection at any time by pointing anywhere
else on the Score window and clicking.

Here's one final exercise for this section.

* Select both channels (B and C) by dragging the pointer along
both of them.

* Close the Score window and pull down the Efx menu.
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Amaze Your
Friends

Work down the menu and choose each option in turn, and see
what effect each one produces. There's no need to stop the
animation -- just keep it running while you select one

option after another. If you want to find out more about

these special effects, look for the Efx menu in the Reference
section.

Before we finish our guided tour with a demonstration of
images that change shape as they move, here's some little
tricks you can use to impress your friends.

#

BurnScene.

Animate the square using real time recording, keeping it
within the confines of the right hand side of the screen.

While the square is still in motion on the screen, reopen the
CheapPaint window and activate the easel containing the
square.

Select the Eraser and erase part of the square.

Presto! Whatever you did to the square in the easel was
mirrored exactly on the "performing” square, even while it was
still in motion. This is another example of the way in which
VideoWorks maintains direct links between inter-connected
windows.

Here's one more trick.

L

BurnScene, close CheapPaint and select one of the
castmembers from the Score.

Do a real time recording by hitting the Play button and
dragging the pointer (and with it, the selected castmember)
around the screen.

Open the Score and select a few frames in the topmost
channel by dragging the pointer across it.
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As you may have already guessed from the loudspeaker icon,
this is the soundtrack channel, and lets you add sound to your
animations.

*  Pull down the Sfx (for "sound effects”) menu, select a
submenu, and then select one of the sounds.

When you Play your animation, you will find that you have added
sound to those selected frames. Go ahead and experiment with
different sounds by making selections from the Sfx menu while
those frames in the sound channel are still highlighted.

The Changing
Sprite

In our last exercise before the tutorials we'll animate an
object that changes shape as it moves. For this exercise, we
will need to create some additional castmembers, so ...

*  Open a new file (select New from the File menu) and open
the CheapPaint window.

Because we have become so proficient at drawing circles, let's
draw some more.

*  First select your fill pattern, and then select the Circle
within CheapPaint.

* Go to the first easel, resize it to the smallest possible
size, and draw a circle.

* Click open a new easel, resize it until it is a little bigger
than the last one, and put a slightly bigger circle in that one.

* Keep doing this until you have five or six circles, each one
bigger than the last.

* Close CheapPaint, drag out the biggest circle from the Cast
window, and place it in the center of the screen.

* Add the frame (Command A, or the Add button).

* Go back to the Cast window and click the second biggest
circle. Don't drag it out - just click it.
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" We now need to change to this second castmember, and we
can do this in any of three ways: by double-clicking it, by
pressing Command E, or by selecting Switch from the
Options menu. As soon as you do that, you will find that
the first castmember has been replaced by the second one.

* Add the second, and keep repeating this procedure until you
have added the smallest circle.

* Now hit Play...

Before you fall asleep staring at the diminishing circles on the
screen, you might want to experiment with some variations on
the above theme. For example, try making the circle grow as it
moves from left to right across the screen, and then shrink as

it moves back. Or try to create the illusion of a ball following

a trajectory as it recedes into the distance. If you have kept up
this far, you should be ready to start on the advanced tutorials
in the next section.






PHAROAH'S PLAGUE

Now that we have gained a working familiarity with some of
VideoWorks' features, let's explore some advanced animation
techniques. Because VideoWorks contains a powerful animatior
editor, working through the following examples will help you
develop editing skills that will actually save you time and

effort. In this tutorial, we will cover some of the basic editing
techniques, such as cutting, copying and pasting.

* Select Open from the File menu, and then double-click
Tutorial #1.

*  Once the various VideoWorks windows have appeared,
select Stage from the Windows menu, this clears the
screen of all the other windows, such as the Cast and the
Panel, and gives you an uncluttered view of the action.

* Start the animation by pressing Command Q or selecting
Play from the Edit menu, and watch the frogs take over.

* While the animation is playing, let's take a look behind the
scenes. First, open the Control Panel (by selecting Panel
from the Windows menu) and experiment with some of the
controls. For example, click the Stop button, and note that
the action freezes at that point.

* Click the Rewind button (the one on the far left) and then
step through the animation frame by frame, by clicking the
Step button. Note as you do so that the animation is made
up of discrete images, each one slightly different from the
previous one. Note also that as you step through the
animation the Frame Indicator in the Control Panel
indicates where you are in the sequence.

* Open the Cast window (from the Windows menu), and note
that this entire sequence, which looks like a plague of frogs,
is created with only six castmembers. In other words, by
using VideoWorks' editing functions, it is possible to
achieve this multiple frog effect without having to create
additional artwork. Let's see how it's done.
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Bring On The
Frogs

* Select BurnScene from the Options menu.

* Itis a good idea to Save often as you progress through this
tutorial. So Save As... now under a different name (such as
"My Frogs"). If you do not Save As... now, then if you Save
during the course of the tutorial, you will overwrite the
original tutorial and it will no longer be available as a
reference.

* Select the first castmember, drag it out and place it on the
Stage, somewhere above the Cast window and towards the
left hand side of the screen.

* Add this frame by pressing Command A (or, if you recall
from our Guided Tour, by clicking the Add button on the
Control Panel, or selecting Add from the Options menu).

* Save. If you want to Save this exercise, you should do so
often. We won't be giving you any move Save reminders
however.

* Select (but do not drag it out) the second castmember by
clicking the second box in the Cast window. Switch to this
new castmember by pressing Command E, selecting
Switch from the Options menu or double-clicking the
second castmember. Once you have done this, you will
notice that the first castmember has been replaced by the
second one.

32




* Before we add a second frame to our movie, however, we
will now need to drag the second castmember a short
distance to create the illusion of movement across the
screen. So drag the second castmember up and to the right,
and then Add this frame.

* Repeat this procedure by selecting the third castmember,
Switching, moving the castmember up and to the right, and

Adding the frame.

P
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* Continue this process to Add the forth and fifth
castmembers.

Y
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* Hit the Play button, and watch the frog jump back and forth
across the screen.

Go Forth and
Multiply

We shall now see how to take this small animated sequence
and, by using the Copy and Paste functions, turn it into a plague—
of Biblical proportions.

* Open the Score window, and resize it so that it displays
the first 25 frames and the first four channels (A-D).
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* Select Frames 1-5 in Channel A by dragging the pointer
across them. Note that we can carry out any of our editing
functions even while the animation is still running, so if you
had stopped the action, go ahead and start it up again so you
can watch your changes take immediate effect.

Tutorial #1 Score =

* Copy (from the Edit menu) these first five frames.

* Select Frame 6 in Channel A (you should be able to see a
flashing vertical bar where you clicked the pointer) and
Paste from the Edit menu.

Note that although the selected sequence has been copied onto
Frames 6-10, nothing seems to have changed: the same old frog
is still jJumping back and forth across the screen. This is
because Frames 6-10 are the same as Frames 1-5 in gyery
respect, including the frog's starting position. But what if we
want Frames 6-10 to start where Frames 1-5 end, so that the
frog takes two hops across the screen? We can do this by
selecting Chain from the Edit menu before we paste the strip
into Frames 6-10. Here's how:

* Select Frames 6-10 and Cut.

* Select Chain from the Edit menu, click Frame 6, and Paste.
Aha! The frog now takes two hops before starting again.
With Chain still selected (you will note that it now has a
check mark next to it) Paste the sequence three more times
until you have filled the first 25 frames of Channel A, and
watch the frog jump all the way across the screen.
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*  Now, let's edit the sequence so that the frog starts its
journey nearer to the middle of the screen instead of its
current starting position at the left edge. To do this, we
will need to stop the action, so Rewind (which both stops

the action and rewinds the film to the first frame) and then

select the whole sequence of 25 frames by dragging the
pointer along Channel A.

* Activate Frame 1 by clicking the frog as it sits in its initial
position,
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and then drag the frog towards the middle of the screen.
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* Hit Play and you will see that the entire sequence has been
shifted right. Even though we effected the shift by dragging
the first frog (i.e., the first castmember) toward the middle
of the screen, it is important to realize that we could have
done so by dragging any of the five castmembers the same
distance, provided you had selected the entire channel
within the Score.

Now let's increase the frog population by further copying
and pasting. First, close the cast window to make more
e room on the Stage.

o *  Select Frames 1-25 of Channel A, and Copy. You can check
to see that the correct frames are selected by looking at the
Range Indicator on the Control Panel.

* Click the first frame of Channel B, and Paste. Note that
although we now have two active sprites, it seems that our
last copy and paste job produced no change whatsoever,
since there is still just one frog hopping across the screen.

In fact, there are two frogs hopping across the screen, but
we can only see one because (and this is important) they are
both occupying the same space (remember, these frogs are
two-dimensional).
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In order to see both frogs, we will need to move one onto a
different path, so stop the action, select Frames 1-25 of
Channel B, and drag the active frame (it doesn't matter
which, remember) down about an inch. Now when you hit
Play, you should see both frogs. If you don't, make sure that
you selected all 25 frames of Channel B and that the frog
you dragged down was active.

(=== Tutorial #1 Score V=
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Let's inject a little realism into the animation by making
the second frog rest a little between hops. Select Frames
12-25 of Channel B, Cut, and Paste the cut sequence
starting at Frame 20.
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* Copy Frame 11 and Paste it into the next eight frames

(12-19). If you had let the animation run while you did this,
you would have seen the second frog disappear when you
moved Frames 12-25 to Frames 20-33, and then reappear as
you copied and pasted Frame 11 into Frames 12-19.

[J===== Tutorial #1 Score
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Now we can do some mass multiplication. First, select all
of Channel A, Copy it and Paste it into Channel C starting
from Frame 15.

Select Frames 1-39 in all three channels by dragging the
pointer diagonally across and down until all the occupied
cells are highlighted.

Copy and Paste the whole sequence into Channels D-F
starting from Frame 18. You do this by selecting Frame 18
in Channels D-F before you Paste.

Finally, let's bring some scenery onto the stage. First,
Rewind the film and select the first frame of the first
available channel (which should be Channel G) either by
clicking that cell in the Score or by clicking the Channel G
box (the seventh box) in the Channel Indicator in the
control panel. Whichever method you choose, you should be
rewarded with a blackening of the Channel G box in the
Channel Indicator.
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Reopen the Cast window, select the sixth castmember (the
small bush), and drag it out onto the stage, placing it in the
bottom right hand corner of the screen.

Tutorial #1 Score
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We want to overlay the bush onto the existing animation
sequence, without otherwise affecting what we have already
done. To do this, we need to Step, rather than Add the frames
containing the bush. The reason is that the Add function works
something like an insert function in a word processor -- it
inserts the selected frames and pushes everything else to the
right. So if we were to Add the sixth castmember, we would
find that frames would be added to all the existing channels,
which would have the effect of "freezing” the frogs while the
bush was on the stage. In other words, what we would see
would be the frog in a stationary position with the bush in the
corner of the Stage. By Stepping the bush, however, we can put
it into Channel G without affecting any of the other channels.
The frog would then appear to be in motion.
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There are several methods we can use to overlay the bush into
the animation. One way is to Step the bush through the 39
frames by using the Step command in the Options menu (or
Command S) 39 times. Obviously, the more frames we need to
Step, the more tedious this method becomes. As an alternative,
then, we can use the InBetween feature, which requires us to
specify only the beginning and the end of a sequence, and leaves
the rest up to VideoWorks. Here's how it works:

* After making sure that the bush is active on the Stage, Step
it in once.

L

Select the range of frames that will include the bush.

Select InBetween from the Options menu (or Command

Q).

The InBetween function allows you to specify the starting and
ending positions, and the number of frames, for a castmember's
movement across the Stage, and fills in (or "in-betweens") the

intervening frames.
e Tutorial #1 Score
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What you should end up with is a moving plague of frogs, with a
standing bush in the corner.
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DRIYEN AROUND THE BEND

In this tutorial, we shall explore the use of mattes, foreground
priority, and some advanced editing techniques.

* Select Open from the File menu, and then double-click
Tutorial #2.

Just as we did in the first tutorial, select Stage from the
Windows menu, and then Play from the Edit menu.

* Feel free to explore behind the scenes by opening the various
windows and observing the effect of various commands.
Open the Control Panel, Stop the animation and Step
through it one frame at a time.

Around the

* As soon as you are ready to go on, open the Cast window,
and BurnScene. We shall now try to recreate this
animation using the existing castmembers.

* If you intend to Save your work as you progress, then Save
As... now under a different name. If you do not Save As...
now, then if you Save during the course of the tutorial, you
will overwrite the original Tutorial.

* Drag the Cast window to the top of the screen to make room.
Select the first castmember, the circular drive, and place it
in the center of the Stage, about 1/4 inch from the bottom
of the screen.
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* Drag out the second castmember, the building, and place it
in the center of the drive.
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Remember that foreground priority is determined by channel
number, which in turn is determined by the order in which
castmembers are dragged out onto the stage. This means that
the earlier sprites are more in the background than the later
ones, so that in this case the circular drive will be behind
everything else, the building will be behind everything except
the drive, and so on.
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* Now drag out the car (the third castmember). Notice that
the car seems to be surrounded by a square, white "matte”.
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We want to eliminate this matte, so first select Blank from
the Options menu to remove the car. Next, select Matte
from the Efx menu. Note that Matte now has a check mark
next to it.

Now drag out the first car and place it in front of the
building, so that it looks like it is sitting on the road.
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Notice that because of the matting process, we have true
figure-ground separation.
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Now that we have everything the way we want i, let's
record the image by Adding (Command A) five frames.
This will make the car pause in front of the building as it
makes its way around the circular drive.

Save. If you want to Save this exercise, you should do so
often. We won't be giving you any more Save reminders
however.

Select the fourth castmember, making sure that Channel C is
still active, and then Switch (Command E).

Using your artistic judgment, drag this new castmember
about one inch to the right so that the tires are on the road
and Add that frame.
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Repeat this process with the sixth castmember -- Switch,

the right hand side of the driveway and Add that frame.
reposition , and Add.

Select the fifth castmember, Switch, and reposition it on

-
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The next step may seem a little strange at first, but it
provides an important lesson on editing, so try and follow it
carefully. We want to bring out the seventh castmember and
place it on the upper part of the driveway behind the
building. So select the seventh castmember, Switch, and
then reposition it on the upper part of the driveway. Did you
see what happened? Because the car has higher foreground
priority, it seems to move in front of the building rather

than behind it, thereby spoiling the illusion of movement
around the building.
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We'll rectify this in a moment, but first let's finish creating
our basic animation. Add this frame, and then repeat the
procedure with the eighth, the ninth, and finally the tenth
castmember, making sure that you are in Channel C the
whole time.

Now Play, and watch the car go (almost) around the
building.
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To rectify the foreground-background inconsistency between
the car and the building, we need to do some minor patching
in the Score, so select Score from the Windows menu.
Note that Channels A-C, Frames 1-12 are occupied. In order
to make the car go behind the building on the upper part of
the driveway, we need first to pinpoint the frame in which

the car and the building cross, and then move the building
sprite for that frame into a higher lettered channel. So,

Step through the animation until you reach the offending
frame (which should be Frame 9). Now we know that the
building sprite occupies Channel B, so select Frame 9 of
Channel B by dragging the pointer across that cell, and Cut.

Note that the building disappears.

We need to paste that frame into the next available channel,
so click frame 9 of Channel D, and Paste.

Presto! The building reappears. When you hit Play, you will
find that the car now moves behind it.

Our next task is to make the car go around the building three
times before it pauses in front of it: so from the Score

select Frames 6-12, Channels A-D by dragging the pointer
diagonally down and across until all those cells are
highlighted. (Alternatively, you can select Frames 6-12 of

all 24 channels by dragging the pointer across the frame
numbers (6 through 12) at the top of the score.)

Copy.

Click Frame 13 at the frame number bar, which will produce
a flashing bar all the way down the Score, and Paste.
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Repeat this process by Pasting the same frames starting at
Frame 20.
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When you hit Play you should see the car go around the
building three times before pausing in front of it.

The Sky's

The Limit
Our next step is to dress the scene up a little by putting in the
sky. Now the sky represents the ultimate background, and,
given perfect planning, would have been put in first. But
perfect planning, however, is a rare commodity in any field,
especially in art, where the artist needs to make esthetic
judgments every step of the way. The point of this exercise,
then, is to demonstrate how easy it is to go back and add
something that, ideally, should have been put in first.

First, we need to make room for the sky in the lowest priority
channel, or Channel A - but Channel A is already occupied by the
circular drive, and if we were t0 move the drive to another
channel, we would be upsetting the relationship between it and
the other sprites. The solution is to move all the existing

sprites down one channel, thereby clearing Channel A for the

sky.
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* Select Frames 1-26, Channels A-D, Cut, and, after selecting
the first frame of Channels B-E, Paste. Note that we have
now made room for a new background sprite without
otherwise affecting the animation.

If we were now to create the sky in the normal manner

(CheapPaint to Cast to Stage) we would be using up more time
and more of the computer's memory than necessary. Instead,
we will create the sky using the Quick-Draw Primitives, a
small set of arawing functions that let you bypass the
CheapPaint-Cast sequence so you can draw directly onto the
Stage. To create the sky using the Quick-Draw Primitives:

* Rewind the film, select Frame 1, Channel A, and close the
Score.

Go to the Cast window, click the rectangle, and then select
the black fill from the Draw menu.

* Select Copy from the Efx menu. We do this because
VideoWorks draws images fastest in the Copy mode.
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Starting in the upper left hand corner of the screen, hold the
mouse button down, and drag across and down, so that the
horizon line starts about 1/4 inch above the upper part of
the driveway.
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Because we want to overlay this image onto the filmstrip
without affecting the other sprites, we need to Step this
image through the 26 frames. We can do this by selecting
Step from the Options menu (or Command S) 26 times
(which is obviously tedious) or by Stepping in the first
frame, selecting the next 25 frames on the Score, and
selecting InBetween from the Options menu (or pressing
Command G). You might recall that this was the technique
we used in the first tutorial when we added the bush to the
scene.

Raising the Roof

We now have a sky but no roof, so let's add a roof to the
building and, as a crowning touch, let's put a flag on top of the
roof.

First, reposition the Cast window (if necessary) so you can
see the top of the building.
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* Rewind the film and select Channel F by clicking the
appropriate box in the Channel Indicator on the Control
Panel.

* Because both the roof and the flag(s) will be against a dark
background (the sky), they will need to be matted, so select
Matte from the Efx menu.

* Go the the roof castmember (the last one in the Cast
window), select it, drag it out and place it so that it sits
squarely on top of the building.
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* Once you are satisfied with the placement of the roof, use
the InBetween feature described earlier or Step it through
the 26 frames.
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Now let's add the flag to the roof. Rewind your film and
select Channel G. Make sure that Matte is still selected,
and drag the first flag out. Place it squarely on top of the
roof, and Step once.
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Go back to the Cast window, select the second flag, Switch,
and Step once more.

Repeat this procedure with the third flag.

Your Score should now show that Frames 1-3 of Channel G
are occupied. Now Copy and Paste those three frames until
all 26 frames of Channel G are occupied.

As a final exercise, create some clouds using either
CheapPaint or the Quick-draw Primitives and make them
move across the sky behind the building, using the methods
you learned in this tutorial.
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E THE YIDEOWORKS PROCESS

Quick on
the Draw

In this tutorial, we will be taking a bare bones flow chart and
spicing it up by using Art Grabber, the Quick-Draw Primitives
and other polishing techniques.

* Open Tutorial #3.

* In order to carry out some of the later exercises in this
tutorial, we will need to Save our work as we progress.
Start by selecting Save As... from the File menu and
choose a new name for the file created. Remember to Save
often throughout the tutorial.

* Select Stage from the Windows menu and Play from the
Edit menu.

Notice that the animation is in the form of a process diagram
which details the VideoWorks system. Note also that the
diagram could use a little spicing up, to make it more
interesting visually. Let's start by framing some of the
elements using the Quick-Draw Primitives.

Ouir first task will be to accent the phrase "Construct a Cast”
by putting a border around it.

* Open the Panel.
* Rewind the animation.

We now need to locate that frame where the phrase "Construct
a Cast" first appears. VideoWorks provides you with several
methods of locating a required frame. If the Score was open,
for example, we could use the Playback Head as a "scratch
bar", or we could click the Playback Head Bar at the required
frame. But since the Panel is open, its easier to use the
pull-down number feature.
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Move the pointer into the Frame Indicator box and drag
your mouse down until the phrase "Construct a Cast” appears
on the State. While still holding the mouse button down,
move the pointer up and down until you reach the frame
where the phrase first appears. This should be Frame 54.

Open the Score, and resize it to display Channel E, Frames
54 through 100. Move the Score down a little so that
"Construct a Cast" is clearly visible.

Select Frame 54 in Channel E.

Open the Cast window. Reposition the Cast so you can have
access to the Quick-Draw Primitives, but without

blocking your view of the phrase we are working on.

Pull down the Draw menu and select the second thickest
line, and None from the fill options.

Select the Rectangle from the Quick-Draw Primitives.
Draw a rectangle around "Construct a Cast", leaving a 1/4

inch border all the way around the text. Don't worry if it is
not centered exactly at this point. We can fine tune it later.

| Consiruct
a Est. |

Add the rectangle to Frame 54 through Frame 174 (which
happens to be the point where "Construct a Cast" quits the
scene) by using the InBetween function. First, select Step
from the Options menu to add the rectangle to Frame 54.
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* Now select Frames 54 through 174, and then select
InBetween from the Options menu.

== —— fine*Iscore E———_———
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If the rectangle needs to be repositioned and Frames 54 through

a 174 in Channel E are still selected, all we need to do is to drag
on the "selection box" in the center of the rectangle. When you
are satisfied with the placement of the rectangle, release the
mouse button and deselect the rectangle sprite by clicking
anywhere else on the Score.

- Construct
a Cast.

* Save. If you want to Save this exercise, you should do so
often. We won't be giving you any more Save reminders,
however.

An Oval
Border

Next, we will construct an oval frame around the phrase "Next
decide what you want...", which is in Channel A, beginning at
Frame 175.

* Scroll the Score so that Channel A is visible and Frame 175
is at about the center of the window. Note the blank frame
at Frame 174. As we noted in the Hints, Tips and
Caveats section, this results in a cleaner segue.

* Move the Playback Head to Frame 175 by dragging it or by
clicking Frame 175 on the Playback Head Bar.

* Select Channel B, Frame 175.

* Select the Circle from the Quick-Draw Primitives.
57



* Drag the pointer from a point an inch above and about an inch
and a half to the left of the phrase until you have an oval
surrounding it.

Next decide what
you want to do
and what gnimation
type will best
suit your needs.

"

Now we need to Step this border into Channel B from Frame
175 through Frame 239. As we did before, we can use the
InBetween function by Stepping the oval into Frame 175,
selecting Frames 175 through 239, and then selecting
InBetween from the Options menu. After the oval border has
been overlaid onto those frames, you can go back and reposition
it more finely, as we did with the rectangle before.

Let's now go back and make the oval frame a little thicker. As
we pointed out in Tutorial #1, esthetic judgments are often
made every step of the way when creating a work of art, and so
it is sometimes necessary to go back and make minor
modifications. VideoWorks' editing features make it easy to
change line thickness, pattern fill and any other feature, even
after the image has been introduced into the animation.
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Make sure the oval sprite (Frames 175 through 239 in
Channel B) is still selected, and select the thickest line

from Draw menu. Presto! The line has been thickened. With
this technique, you can make any changes you wish by
selecting from the Draw menu.

Next decide what
you want to do
and what gsnimation
type will best
suit your needs.
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Rewind and Play and watch your creation. Make sure you
can still see the Score, Cast and Panel, and let's move on to
the next embellishments.

Be sure Channel B is still visible and move the Playback
Head to Frame 381. (You may need to move any windows
that are in the way of the phrase "Frame by Frame
Animation" at the top of the screen. Incidentally, the Panel
is movable. By moving the pointer right up against the Menu
Bar, you can drag the Panel and relocate it.

Select Frame 381, Channel B.

Select the Rectangle from the Quick-Draw Primitives, and
construct a border around the phrase "Frame by Frame
Animation".

{ I. Frame by Frame |
Animation |

Use the Step and InBetween functions to overlay the
border in Channel B from Frame 381 through Frame 478.
Adjust the placement of the border as necessary.
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* Move the Playback Head to Frame 523.

Note that the phrase "Real-Time Animation" is in the exact
same position as the phrase "Frame by Frame Animation”, and is
roughly the same size. As a shortcut, therefore, we can Copy
the border that is around the first phase ("Frame by Frame
Animation™) and put it around "Real-Time Animation”.

* @Go back to Frame 381 in Channel B and select the 63 frames
we need by dragging from Frames 381 through 444.

* Copy those frames and Paste them beginning at Frame 523
in Channel D. If necessary, you can now select those frames
and reposition the border.

As you may be aware by now, VideoWorks allows you to carry
out operations in any order without any fear of animating
yourself into a corner. We can highlight this ability by making
a border move around from one phrase to another, by using the
same Quick-Draw method we used before.

* Move the Playback Head to Frame 864.

* Reposition the windows so you can see the phrase "Reorder
sprites to set priority levels" at the bottom of the stage.

* Select Frame 864 in Channel J.

* Select the Rectangle with Rounded Corners from the
Quick-Draw Primitives.

* Construct a border around the phrase "Reorder sprites...",
leaving 1/8 inch border all the way around.

- Reorder

1 sprites to set [
priority levels.

N .

-

* Using the Step and InBetween functions, overlay the
border all the way through to the end of the animation,
Frame 1023.
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At this point, we have a border around the "Reorder sprites..."
phrase from Frame 864 through the end of the animation. What
we want to end up with, however, is that same border moving
from phrase to phrase. To do this, we can move the same
border from one phrase to another, thereby saving us the effort
of constructing a new border each time. Let's now move the
border at regular intervals of 20 frames.

* Close the Panel and the Cast.

* Select Frames 884 through 903 in Channel J.

* Move the Playback Head to Frame 884 and resize the Score
so that Channel J and Frames 865 through 910 are visible.

You should be able to see the small "selection boxes" on the
border of the "Reorder sprites..." phrase.

* Drag the border from around the "Reorder sprites...” phrase

and put it around the phrase "Save to Disk", centering it as
we did before.

Save

to Disk

The border is now around "Save to Disk" from Frames 884
through 903. Remember that you can always Play your
animation without affecting it, so if you want to take a look at
your handiwork to this point, feel free to do so.

Our next task will be to move the same border to the next
phrase -- "Copy scenes from other animations”.

* Scroll through the Score until you can see Frames 904
through 925.
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Two Way
Stretch

* Select Frames 904 through 923 and move the Playback
Head to Frame 904.

Note that the border is currently around "Reorder sprites...".
This is because when we moved the border around "Save to
disk", we had selected only through Frame 903. Therefore, at
904, the border goes back tom the "Reorder..." phrase.

* Move the border from "Reorder..." to "Copy scenes from other
animations”.

Copy scenes
) fromrother ]
animations

* Repeat this procedure, selecting 20 frames at a time in
Channel J, moving the Playback Head and moving the
border from one phrase to another until all have been
highlighted. As you know by now, VideoWorks doesn't care
what order you use.

* Play, and taste the fruits of your labor.

Let's spruce up the animation further by using VideoWorks'
stretching function.

* Scroll through the Score so you can see Channel A and
Frames 478 through 495. Move the Playback Head to
Frame 478.

* Reposition the Score Window so you can see the phrase "Or
Use...", which is in the middle of the Stage.

It looks small and lonely sitting all by itself in the middle of

the Stage, so let's enlarge it. We can do this in one of two
ways: by creating a new and bigger castmember, or by
stretching the sprite on the Stage. Because the latter method
achieves the same result with a savings in memory (and time),
let's make the image bigger by stretching it.
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Select Frames 478 through 495.

Click and drag any of the four corner "size boxes" (or
"selection boxes") until the dotted outline is about one inch
square. By holding down the Shift key as you do so, the
image will be constrained and will be stretched equally in
all directions.

L

AR

USE...

Grabbing with

Art Grabber

Now let's add some artwork to the animation by "grabbing"
images from the Art Disk.

&

W

From the Apple menu, select Art Grabber.
Pull down the Grabber menu and select Open.

Select Chart Kit. If you are using only the Macintosh's
internal drive, you will need to Eject the VideoWorks disk
first and then insert the Art Disk. VideoWorks will prompt
you when you need to swap disks.

We want to Grab the five arrows from Chart Kit, (at the
bottom left hand corner of the page) and Paste them into
available cast windows,

*

3 /—-\
N

First, draw a selection rectangle around the first image you
wish to grab (grab one arrow at a time) by dragging the
crosshair selector across the image you want to grab while
holding down the mouse button.

63



* Next, select Grab from the Grabber menu, and Close the
Art Grabber Window.

* Open the Cast, select the first available cell, and Paste.
The image will be pasted directly into the cast window.
Repeat this process until each of the arrows is in the Cast.

* Using the same technique, Grab a fly from the Bugs file,
and Paste it into a cast cell.

Fine#3 Cast _

* Resize the Score so you can see Frames 139 through 173 in
Channel G, and move it to the bottom of the screen.

* Move the Playback Head to Frame 139.

* Select Frame 139, Channel G.

* Select the "down" arrow castmember, drag it onto the Stage
and position it about 1/4 inch above the "Construct a Cast"

box.
4
Construct
a Cast.

* Step it in five times (or use InBetween).

* Select Frames 139 through 143 (the five frames you just
Stepped) in Channel G.

* Copy the selected frames and Paste them beginning at
Frame 149 in Channel G. Skip five frames, and Paste them
again from Frame 159. Repeat this procedure, Pasting them
again beginning at Frame 169. This staggered Pasting will
yield a flashing arrow on the Stage.
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Now we can repeat this procedure with the other two small
(diagonal) arrows. Note that we can save effort by doing both
at the same time.

* Resize the Score so you can see Channels G, H and |, and
move the Playback Head to Frame 139.

* Select Frame 139 in Channel H.

* Drag out the first arrow so that it points to the "Construct a
Cast" box.

Construct
a Cast.

&

* Select Frame 139 in Channel |, drag out the second arrow
and place it on the other side of the box.

-

Construct
a Cast.

& %

* Step five times.

* Select Frames 139 through 143 in Channels H and |, Copy,
and Paste at Frames 149, 159 and 169,

* Play. You should be able to see the three arrows flashing in
unison.
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Now, let's add some more arrows. This time, however, let's
make them flash alternately.

* Scroll the Score so you can see Frames 425 through 478 in
Channels F and G.

* Move the Playback Head to Frame 429.

* Select Frame 429 in Channel F, drag out the arrow and place
it as shown below.

Arrange
Castmembers hse
on stage. Frame.

* Step it in eight times (or use InBetween).

* Select those same eight frames, and Copy and Paste them
beginning at Frames 445 and 461.

* Move the Playback Head to Frame 437.
* Select Frame 437, Channel G.

* Drag out the last arrow and place it as shown below.

Arrange
Castmembers Add
on stage. Frame.

* Step it in eight times.

* Copy those last eight frames in Channel G, and Paste them
beginning at Frames 453 and 469.

* Play.



Stealing
- the Scene

a Now that we have seen how to "borrow" still art for animating,
let's see how to borrow artwork that is already animated,
thereby saving even more time and effort. Let's put an example
of frame by frame animation and of real-time animation into

our diagram. First, let's do a frame by frame animation, and

g we'll start by stealing a frog from our first tutorial.

T * Save and Open Tutorial #1.

oy * Open the Score.

* Select Frames 14 through 19 in Channel A.
* Copy.

* Open the new file we have been working in.

* Open the Score and make sure that Frames 310 to 360 in
Channel E are visible.

iz * Move the Playback Head and select Frame 318 in Channel
E, and Paste.

The frog scene should now appear on the Stage and the five frog
— castmembers should appear in the Cast.

R E : Finn#ﬁ Cast |

" 1. Frame b}r Frama 2. Real-Time
Animation Animation
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* Paste the frog scene five more times so that it extends
until Frame 353.

= Fine#3 Score
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Because the frog is covering the text, let's move him, using the
same technique we used with the Quick-Draw Primitives.

* Select Frames 318 through 353, and drag the frog down the
Stage below the text. Step through, and make sure that
when the frog reaches its highest point, it doesn't obscure
any of the text.

Real Time
Animation

* Scroll the Score so that Channels D, E and F and Frames 310
to 360 are visible.

* Using the Speed Control, slow the animation down to its

slowest speed. This makes it easier when adding real-time
animation.

* Select the fly castmember we grabbed using Art Grabber.
* Select Place (or Command T).

* Position the Playback Head at Frame 318 and select
Channel F.



We are going to do this "on the fly", so watch carefully.

W

Place the pointer under "Real-Time Animation®, and while
holding down the Option key, hold down the mouse button
and move the fly around until the Playback Head reaches

Frame 355.

As soon as the Playback Head is at 355, release the mouse
button and Stop the animation by pressing Command W.
2. Real-Time )
Animation

&

If the first frame of Channel F is not aligned with the first
frame of Channel E, select the entire animation in Channel F,
Cut, and Paste it beginning at Frame 318.

Trim off any excess frames beyond Frame 353 by Cutting or
Clearing.

—————— Fine#3 Score
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Increase the frame rate to 10, select Stage, and Play.

Watch the animation, and note whether the frame rate is
appropriate to the information being displayed. If it is moving
too fast, slow it down. Now when you Save, the frame rate
will be saved along with the animation.
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HINTS, TIPS AND CAYEATS

. When cutting from one scene to another (i.e., to one
with a new selection of sprites), insert a blank frame
down all 24 channels, to give the Macintosh a
chance to "catch its breath”. The result will be a
cleaner segue.

. Be economical in your use of the special effects in

the Efx menu. With the exception of Copy, the Efx modes
tend to use a lot of processing time, and could slow down
your animations. In particular, use the Matte function only
in those frames when one object passes in front of another.

. Animate only that part of the picture that has to

move. For example, if you want to create a face with only
the lips moving, don't redraw the entire face for each
frame. Rather, use the same face as the castmember,
changing only the lips each time. By the same token, use
smaller figures (castmembers) whenever possible, for
"cleaner” animations -- the bigger the image, the more
likely it is to "flash" from one frame to the next.

. Plan ahead. Decide which images should have foreground
priority and put them in later channels. Although
VideoWorks lets you swap channels easily, it is better to
do it right the first time.

. To achieve maximum smoothness in your animations
(for example, if you wish to make clouds move smoothly
across the screen), use the Tweak and/or the
Constrain function.

. You may find that using the Command key
equivalents of the more common functions speeds
up your work. Also, when using the Command key
equivalents, you can use both hands as you work.

. Save your work often. There is nothing more
discouraging than losing hours of work because of a
disconnected plug. For similar reasons, you should keep
backup copies of your favorite animations on separate
disks.
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8.

10.

11.

12.

13.

14.

Keep at least 70K available on your system disk at

all times. Once you have worked through the tutorials, it
is a good idea to move them to a separate data disk, as you
should with all your own creations.

When using text in your animations, make sure that

the text remains on the screen long enough to be
understood by the viewer. You should consider, for
example, that as the creator of the text, you will have read

it many times and so may tend to underestimate the amount
of time the viewer may need to read it. Consider also that
if you have movement on the screen while the text is
displayed, the movement may distract the viewer from
reading the text.

Don't be afraid to look in your mirror or watch your
friends to make your animations appear as real as
possible. Model your animations upon real life.

Do some "pencil testing” before creating your final
castmembers to see if you can get by with fewer
castmembers for a given movement. Conversely, if your
animation appears "choppy", then you may need to create
additional castmembers.

Group castmembers together within the Cast so
that they fall into "animation groups", making them
easily accessible as you work.

You can cut scenes or sequences from existing
animations and store them in the Scrapbook for use
in later animations. This is particularly handy when
using a 128K Macintosh since this eliminates repetitive
opening and closing of files.

Realize that adding channels to an animation or
increasing sprite size will slow down the
processing time. The Quick-Draw Primitives and the
stretching feature will also slow down the processing
time. Therefore, before starting your animation, try to
anticipate any loss of speed that may result as you add
channels.
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15.

16.

.

18.

19.

20.

21.

22.

Blanks in your cast window cannot be eliminated by
direct cutting and pasting without affecting your
animation. However, such holes can be eliminated by
cutting the entire score and pasting it into a New file. This
process will eliminate all blanks in the cast window.

Use the Quick-Draw Primitives whenever possible
to save memory.

The Demo function in VideoWorks is an extemely
powerful tool. With it you can link film strips together,
and cycle through them indefinitely. If you run out of room
in one file, continue the animation in a second file and link
them together using Demo List.... In-store advertising and
point-of-purchase displays can be created and left running
in a retail store.

Channels are automatically assigned when a cast
member is dragged out onto the stage. However, in
real-time animation, the channels are not
automatically assigned. You must explicitly select
another channel if you do not want the existing animation
in that channel erased.

VideoWorks deals with Fonts like any other

Macintosh application. If you have any Fonts you really
like, you can add them to the system with the Font Mover or
Resource Editor.

When using Sfx, synchronize your sounds with your
animation for added effect. If for instance, you go
from a screen of graphs to a screen of charts; at exactly
the frame that the screen changes, add a little musical
ditty to enhance the transition.

Animate business presentations using charts and
graphs from Ensemble™. Anything that can be cut onto
the Clipboard can be pasted into the VideoWorks Cast.

Use a digitizer to add real-world scenes into
VideoWorks. Once these images are in the Cast, you can
animate or combine them with your own artwork.
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23. Use the art from the Art disk (or other art disks on the

24,

25.

market such as Art Grabber with Body Shop™) to create
your own animations. Animation sequences from
the Movies disk can be combined with original
animations by copying from one file to another.

The No Erase option in the Efx menu can be used to
create a trailing effect on the Stage. This is

especially useful in making a point or grabbing someone's
attention.

Short sound effects (for example BDrum) cannot be

strung together in a contiguous stream. You must put
a blank frame between sounds to allow them to “retrigger.”

74



REFERENCE

VideoWorks has so many special features that it would be
impossible to demonstrate each one through tutorials or guided
tours. Consequently, we have included this handy reference
section so that you can look up any VideoWorks feature to find
out exactly what it does and how it works. Items in this
reference section are classified by menu, moving along the
menu bar left to right. To find more information about a
particular feature, just determine which menu includes that
feature and then look it up under that menu.

The APPLE Menu

About VideoWorks...

Art Grabber
Scrapbook
Alarm Clock
Note Pad
Calculator
Control Panel
Puzzle

About VideoWorks...

Introducing your VideoWorks program authors.

Desk Accessories

The standard Macintosh desk accessories are included with
VideoWorks. Please refer to Macintosh, your user's guide for
more information.

Art Grabber

As its name implies, Art Grabber lets you "grab" any image
from any MacPaint document and transfer it to CheapPaint for
modification, or straight to the Cast window for immediate

animation.
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To use Art Grabber select Art Grabber from the Apple Menu.
A Grabber menu will appear on the right hand side of the menu
bar.

The GRABBER Menu

ClipBoard
Grab

ReOpen
Show Page

Open
Open allows you to open a MacPaint document from disks in
either disk drive.
ClipBoard
ClipBoard displays the current contents of the ClipBoard.
Grab

Grab instructs Art Grabber to copy the contents of the
selection rectangle onto the ClipBoard. Alternatively, you can
select Copy from the Edit Menu (see below). Grab can also be
used to copy a selection from the ClipBoard itself. Once a
selection has been grabbed it can be Pasted (see below) onto
the selected window (such as CheapPaint or the Cast).

When you select the document from which you wish to grab an
image (by double-clicking it), it appears on the Art Grabber
window. Take the crosshair selector and drag it diagonally
across the image you want while holding down the mouse
button. As you do so, the selection rectangle (or the "marquee
box") appears and surrounds the image. Finally, select Grab
from the Grabber Menu. This stores the image onto the
Clipboard, from which you can transfer it either to CheapPaint
or straight to the Cast window.
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ReOpen opens the most recently opened MacPaint document.

Show Page

Show Page displays the entire page in reduced format,
making it easy for you to choose the position of the viewing
window.

The FILE Menu

e

Open...

Save

Save RAs...
Revert
Demo List...
Demo

Quit

New opens a new file and erases the one currently in memory.

Open... opens a file stored on a disk. A Dialog Box will appear
with a list of all of the Files on the disk. Double-click the file
you want to open or select the file and click Open.

Save instructs VideoWorks to Save the file currently in
memory. If an earlier version of the same file has already been
saved, VideoWorks will overwrite the earlier version.
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Save As...

Save As... is used for saving a new file for the first time or
for saving the current version of an existing file under a
different name. If you use Save As... to rename an existing
file, you end up with two files -- the original version and the
updated version.

Revert

Revert returns you to the last saved version of the current
file.

Demo List...

Demo List... allows you to arrange or rearrange the playback
order of your animation files, so that you can link them

together in any order to create your own "feature length"
movie. Selecting Demo List displays a text editor in the form

of a dialog box. You can enter file names (up to a total
maximum of 255 characters) directly from the keyboard or by
selecting them from a disk directory. This directory is

accessed by clicking the Directory button. As with any changes
made to a VideoWorks file, you will need to Save the Demo List
to retain a permanent record on the disk.

Demo plays the files in the current Demo List. To stop the
demo, move the pointer to the top of the Stage, pull down the
File menu and select New, Open, or Quit.

Quit
Quit tells VideoWorks to finish the current session and return

to the Desktop. VideoWorks will ask you if you want to save
the file currently in memory.
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The EDIT Menu

UnDo

UnDo *Z

Cut ®H
Copy ¥C
Paste U
Clear
Chain

Play 20
Stop %W)|

UnDo lets you undo your last action. In CheapPaint, for
example, the Undo command works just like it does in MacPaint.
Also, if you are editing, UnDo will cancel your last command,
such as Cut, Copy, Paste, etc., or if you should BurnScene
inadvertently, UnDo will restore your animation. UnDo will also
undo Adding, Stepping and real-time recording.

Command Key(s): Command Z and (in CheapPaint only) the
~* key (next to the V1 key.)

Cut removes the selected image or sequence of images from its
current location and stores it in a temporary file on the
Clipboard. The Cut sequence can then be Pasted into a new
location (for Paste, see below).

Command Key: Command X
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Copy

Copy makes a copy of whatever is selected and stores it in a
temporary file on the Clipboard. Unlike the Cut command (see
above), Copy does not remove the selected sequence from its
original location. Copy is used when you want to reproduce,
rather than move, an image.

Command Key: Command C
Paste

Paste puts whatever is on the Clipboard into a new location,
specified by clicking with the pointer. When you select Paste,
the sequence will begin at the selected cell.

Command Key: Command V

Clear

Clear removes the selected image or sequence altogether,
without saving it on the Clipboard. Clear is used when you have
no further use for a particular image or sequence or when you
do not want to affect what is stored on the Clipboard.

Chain

Chain is used when you wish to link repeating sequences
together to create one continuous motion across the screen.
Normally, if you Copy and Paste a sequence so that it repeats,
the copied sequence will be exactly the same as the original
sequence in every respect, including its starting position. But
if you select Chain before you Paste, the second sequence will
begin at the point where the original sequence ends. Note that
it makes a difference which frame you select to begin the
copied sequence. For example, if you overlay the first frame of
the copied sequence onto the last frame of the original
sequence, then the copied sequence will begin at those x.y
coordinates which mark the end of the original sequence.
However, this has the added effect of replacing the last
castmember of the first sequence with the first castmember of
the copied sequence. If you wish to preserve the last
castmember, then you should select the next empty cell to
begin the copied sequence. This will have the effect of
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preserving the last castmember, but will also have the effect
of repeating the x,y coordinates from the end of the original
sequence to the beginning of the copied sequence.

Play
Play starts an animation. Selecting Play has the same effect
as clicking the Play button on the Control Panel (see below). In
addition, when the Score is unoccupied, selecting Play is
equivalent to "rolling the cameras” since it is the first step in
producing a real time animation.
Command Key: Command Q

Stop

Stop stops the action. Selecting Stop has the same effect as
clicking the Stop button on the Control Panel (see below).

Command Key: Command W
The OPTIONS Menu

Dptions|

BurnScene

Place ®T
Step xS
Add #A
BackStep ®D
KillFrame  %F
Blank #B
Rewind ®R
Switch ®E
InBetween X6

BurnScene

BurnScene completely clears the Score, while preserving the
Cast. Use BurnScene only if there is nothing in the current
Score you wish to preserve.
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Place

Step

Place lets you position a castmember on the Stage without
having to drag it out first. Selecting Place changes the pointer
into a "modified crosshair.” Clicking this crosshair anywhere
on the Stage will cause the selected castmember to appear in
that position. The castmember can be selected before or after
Place is selected.

Command Key: Command T
Shortcut: Access the Place function from the Quick-Draw
Primitives in the Cast window.

Step has a dual function. First, when there is no selected
castmember on the Stage, the Step command simply steps
through the animation frame by frame, without otherwise
affecting it. Second, if there is a selected castmember on the
Stage, the Step command will overlay that castmember into the
Score. For example, dragging a new castmember onto the
Stage and Stepping will overlay that castmember onto the blank
cells in the Score. But if you should arrive at an occupied cell
(for example, if the blank frames were in the middle of a
sequence), the original castmember in that channel will have
precedence over the newly introduced castmember. You can
override this precedence, however, by holding down the mouse
button as you Step. Step can also be accessed via the Control
Panel (see below). In addition, you can Step through a sequence
(but without affecting the Score) by dragging the Playback head
to the right in the Score (see below).

Command Key: Command S
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KillFrame

Blank

Add begins an animation or adds a frame to the Score by
inserting it at the selected location, pushing the existing
frames to the right like the insert function in a word processor.
Unlike the Step command, which affects only the selected
channel, Add inserts frames throughout the entire 24 channels.
Therefore, if you wish to introduce a new castmember without
affecting the existing animation, you should use the Step
function (see above).

Command Key: Command A

BackStep steps you through the animation backwards, one step
at a time, without otherwise affecting it. Backstep can also

be accessed via the Control Panel (see below) or by dragging
the Playback head to the left in the Score (see below).

Command Key: Command D

KillFrame clears the selected frame. It does so throughout

the 24 channels, like the Add function, so it should be used only
if you need to remove frames across all 24 channels.

KillFrame does not affect what is stored on the ClipBoard.

Command Key: Command F

Blank removes the selected castmember on the Stage or in the
Score from the animation without affecting the Cast or the
other frames or channels.

Command Key: Command B



Rewind

Rewind, which can also be accessed via the Control Panel (see
below), rewinds the animation back to Frame 1, without
otherwise affecting it.

Command Key: Command R
Switch

Switch changes the castmember selected on the Stage to the
one selected in the Cast window. When Switching from one
castmember to the next, VideoWorks keeps the images
registered by using the center of the castmember as a
"registration pin".

Command Key: Command E
InBetween

InBetween lets you specify the starting and ending position of
a sequence and leaves it up to VideoWorks to fill in the
intervening frames. If the castmember being included in the
sequence is to remain stationary, then VideoWorks will simply
overlay that castmember into the sequence just like a series of
Step commands. If, on the other hand, the castmember's
ending position in the sequence is different from its starting
position, VideoWorks will calculate each increment of motion
by dividing the total movement by the number of frames, and
fill in the intervening frames accordingly.

Command Key: Command G.
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The WINDOWS Menu

Panel

uindows, |

stage ®1
Panel %2
Cast ®3
Score x4
CheapPaint %5
Tweak B
Monitor %7

Stage clears the screen of all other windows to provide an
uncluttered view of the action. After you have selected Stage,
you can add any of the other windows simply by selecting them
from the Windows Menu.

Command Key: Command 1

Panel is the main control console. The Panel is a "modeless”
window, meaning that it does not have to be active for its
functions to work. Most of the Panel's functions are also
accessible through the Edit and Options menus and by command
key equivalents. You should experiment with the various
control methods to see which ones suit your particular
purposes best.

Command Key: Command 2
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step

back
rewind step st|up play add repeat
Pgnel

I ! -3 channel
¢ ‘ I T indicator
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5pee
t':h control
sound speed frame range
switch indicator indicator indicuturs

The following is a description of the Panel's functions, taken
from left to right:

Rewind winds the animation back to Frame 1, without
otherwise affecting it. You can also rewind the animation by
selecting Rewind from the Options Menu (see above), or by
clicking the first frame in the playback head bar in the Score
(see below).

Command Key: Command R

Backstep steps the animation backwards one frame at a time
without otherwise affecting it. Backstep's function is

identical to Backstep in the Options Menu (see above).
Command Key: Command D

Stop stops the action, and has the same effect as selecting
Stop from the Edit Menu (see above).

Command Key: Command W

Step allows you to step through the animation one frame at a
time, or to overlay a new sprite onto an existing animation
without affecting the other channels. The Step function is

described fully in the Options Menu (see above.) The Step
function can also be accessed via the Options Menu.

Command Key: Command S
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Play starts the animation from the current frame. It has the
same effect as selecting Play from the Edit Menu (see above).

Command Key: Command Q

Add is equivalent to Add in the Options Menu (see above), and
inserts the selected castmember into the animation at the
selected location and pushes the existing frames to the right.

Command Key: Command A

Repeat -- when the Repeat button is highlighted (black), the
animation forms an endless loop, so that the sequence is
restarted from Frame 1 automatically. Repeat is a toggle,
which means that clicking it alternately activates and
deactivates the function.

Channel Indicator is the 24-grid matrix at the right- hand

side of the Panel and indicates which channels are currently
occupied and which of those is currently active. Channels
which are currently occupied but inactive are indicated by gray
squares, while the active channel is indicated by a black
square. In addition, the Channel Indicator also doubles as a
channel selector: by clicking any of the 24 squares you can
select the corresponding channel. You can select more than one
channel at a time by holding down the Shift key while clicking
the squares.

The Light Switch on the lower row of the Panel toggles
between a white and a black Stage.

The Sound Switch turns the sound on or off. When the
speaker icon is white, the sound is on.

The Speed Indicator displays the frame rate, with a range of
3 frames/second to 60 frames/second.

The Speed Control controls the playback speed, and is
operational even during playback. Dragging the elevator to the
left slows down the animation, while dragging it to the right

speeds it up.
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Cast

The Frame Indicator shows, by frame number, your current
position in the animation. In addition, you can access any point
in the animation by using the "pull down number” function. This
is done by moving the pointer into the Frame Indicator box and
dragging the pointer. Dragging the pointer down and/or to the
right increases the frame number, while dragging it up and/or
to the left decreases the number. As with the Playback Head in
the Score (see below) scrolling through the frame numbers
also scrolls through the animation.

The Range Indicator shows the beginning and ending frame
numbers of the selected animation sequence. The left number
indicates the first frame while the right one indicates the last
frame of the sequence. As with the Frame Indicator, you can
define either number by using the pull down number function.

Cast is the repository (or dressing room) for castmembers
awaiting animation. When the Cast window is active, clicking
any castmember will select that castmember. Alternatively,
any castmember can be selected by pressing the corresponding
number key -- "1" for the first castmember in the selected row,
"2" for the second castmember, etc. The selected castmember
is indicated by a heavy border around it. Once selected, the
castmember can be animated in real time, or dragged onto the
stage for frame by frame animation.

Castmembers are either created in the CheapPaint window (see
below), "grabbed" using Art Grabber (see above), or Pasted from
the Scrapbook or from other animations. Once an image is
created and a new easel is opened, VideoWorks automatically
puts the new castmember into the Cast window. In fact,
VideoWorks constantly updates the Cast window to reflect any
changes that are made in CheapPaint, and it does so whenever a
new (or another) easel is opened.

Command Key: Command 3



bank selector
(S12k only)
I

= Tutorial #1 Cast =

I I'-HJ_'. . | |

S
1

[yl OO

1% ol

Score

cells row Quick-Draw
selector primitives

The Row Selector in the Cast window has room for 64
castmembers on a 128K Macintosh and 256 castmembers on a
212K Macintosh. Only one row of castmembers is visible at one
time, but you can select any row by clicking the appropriate box
in the row selector to the right of the castmembers. With the
512K Macintosh, an extra column of boxes is available to the
right of the Row Selector. This column is the Bank Selector,
and lets you select from four banks of 64 castmembers each.

The Quick-Draw Primitives on the right hand side of the
Cast window is a set of five primary graphic tools and the
default pointer. The Quick-draw primitives let you bypass the
standard CheapPaint-Cast-Stage sequence by making it
possible to place images directly onto the Stage (see Tutorial
#2). This represents a savings in memory since VideoWorks
does not have to keep track of easels and castmembers. The
primitives are most useful for creating large background areas.
The six functions provide, from top to bottom, left to right:

the pointer; the Place function (see above); rectangles (or
squares, when constrained - see above); rectangles with
rounded corners; ovals (or circles when constrained); and
straight lines.

Score is VideoWorks' equivalent to a "dope sheet" or "cue” in
film animation, and contains, in one convenient window, all the
information you need to edit your animations. Each column
represents one frame of the animation. VideoWorks has a
maximum capacity of 25 channels, consisting of 24 video
channels and one sound channel.
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The sound channel is in the first (top) row of the Score and is
represented by the loudspeaker icon. To add a soundtrack to
your animation, first select the frames you will be adding the
sound to (by dragging the pointer across them) and then select
the appropriate sound from the Sfx Menu (see below). You can
add as many different sounds as you wish by following the
same procedure each time.

Each video channel is represented by a letter (A through X) and
is further divided into two rows. Depending on which of the
three Display Switches is currently on (by way of the three
icons in the upper left hand corner), each of the two rows
provides information about the castmembers and other aspects
of the animation.
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With the leftmost Switch selected, the upper row in each
video channel refers to the jdentity of the castmember in each
frame. Specifically, if a cell in the upper row contains a small
hyphen-like symbol, this indicates that the castmember in that
frame is the same (that is, has the same identity) as the
castmember in the immediately preceding frame, or in other
words, that there was no change in castmembers from the
previous frame. If, instead, the cell contains an open square
symbol, this means that a castmember was newly introduced in
that frame. If the cell contains a closed square symbol, this
indicates that the image was created using the Quick-Draw
Primitives and was newly introduced in that frame.

The lower row of cells in each channel refers to the motion of
the castmember relative to its position in the previous frame.

If a cell in the lower row contains a small octagonal symbol

(like a small stop sign) this means that the castmember in that
frame occupies the same position (that is, has the same x,y
coordinates) as the castmember in the immediately preceding
frame. Any movement by a castmember relative to the previous
frame is indicated by a small arrow. Because these arrows

also indicate the direction of the movement, they are known as
Relative Motion Indicators.
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With the middle Switch on, the information in the top row is
identical to that provided by the leftmost Switch. The bottom
row tells you which Efx mode is presently selected. For
example, if the letter "C" appears in this row, this indicates
that the Copy mode was selected during that sequence.
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When you select the rightmost Switch, you are provided with
information about the castmember's grigin. The top row
indicates which of the eight rows of the Cast window the
castmember came from, while the bottom row indicates the
cell in that row.

Any frame in any channel (or any combination of frames and
channels) can be selected by dragging the pointer across the
corresponding cells in the Score. Frames can be selected
across all 24 channels by dragging the pointer across the

frame numbers at the top of the Score window. An entire block

—

of frames and channels can be selected by dragging the pointer —

diagonally across the desired block. In addition, an entire
channel can be selected by double clicking the channel letter.
Once a block or group of frames is selected, it can be edited,

by way of the Cut, Copy, Paste and Clear functions (see Edit __
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Menu, above), or varied by using the special effects from the
Efx Menu (see below).

Just below the last visible channel there is a small black
square which moves from left to right whenever an animation
is in progress. This is the Playback Head. It monitors the
animation and keeps track of your current position in the
sequence. In addition, the Playback Head allows you to access
any frame simply by dragging it to the desired position, in
either direction, or by clicking the Playback Head Bar at the
desired frame. In fact, dragging the Playback Head makes it
operate as a kind of "scratch bar”, letting you scroll through the
animation forwards or backwards.

Command Key: Command 4

CheapPaint

CheapPaint is VideoWorks' main graphics tool, and usually
provides the first step in creating an animated sequence.
Although CheapPaint doesn't have all the capabilities of its big
brother MacPaint, it does include some additional special
features. For example, it is resizable and scrollable.
CheapPaint's functions are accessed through the row of icons
along the top of the window. These are described below.

Command Key: Command 5
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New Easel causes a new easel to appear in the CheapPaint
window, ready to accept a new image. The image created in the
new easel is placed in the first available location in the Cast
window. Easels can be resized by dragging on the handle on the
lower right corner, and can be repositioned within the confines
of the CheapPaint window by dragging the thick bar at the top.

FatBits magnifies the selected easel at the point last touched
by the pencil or paintbrush (like FatBits in MacPaint) and
allows modification of the image at the pixel level. Once in
FatBits, clicking the icon (or the actual size box in the top, left
corner) reverts the image to the original state. As a shoricut,
while using the pencil, holding down the mouse button and the
Command key at the same time places you in FatBits at that
location in the image. All of the CheapPaint tools work in
FatBits.

The PaintBrush is a drawing tool that allows you to select

the size and shape of its lines from a special menu. This menu
appears whenever you double click the PaintBrush icon and lets
you choose from nine different shapes and sizes. The
PaintBrush also draws with the selected fill pattern from the
Draw Menu (see below).



The Pencil is identical to the Pencil in MacPaint and works

the same way whether in standard mode or FatBits. The Pencil
creates black lines on a white background, and white lines on a
black background. Double clicking the Pencil immediately
places you in FatBits. In addition, with Pencil selected,

clicking the Option key turns the pointer into a Hand, letting

you move the image around the window.

The Eraser is identical to the Eraser in MacPaint. You can
erase any part of an image by dragging the eraser over it.

Text is similar to the MacPaint text mode and makes it
possible to include text in your animations. Enter text by
clicking the icon and then clicking on the easel where you wish
the text to begin. Whatever you type will appear at the cursor.
You can select the Font and Style from the appropriate menus
(see below).

The Rectangle generates rectangles of any shape and size. By
holding down the Shift key as you drag the pointer, you can
“constrain” the rectangle into a perfect square. The resulting
rectangle or square will be filled with the fill pattern selected
from the Draw Menu (see below) and bounded by the line
thickness from the same menu.

The Circle draws circles when constrained, and ovals when
not. And just like the Rectangle (see above), the resulting
ovals or circles will be filled with the selected fill pattern and
bounded by the selected line thickness.

The Line draws straight lines. When constrained the Line
Maker draws lines vertically, horizontally or at 45 degrees.
The line width is determined by the selected line thickness
from the Draw window.

The Selector lets you encircle and drag any image (or part
thereof) to any other part of the selected easel. To use the
Selector, drag diagonally across the image you want to select.
When you release the mouse button the image will be
surrounded by the selection rectangle. You can now move the
surrounded image anywhere within the same easel by moving
the pointer into the selection rectangle and dragging. The
Selector can also be used to Cut, Copy and Paste portions of
selected images. When moving a Selected image, holding down
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Tweak

Monitor

the Shift key will constrain the movement to the vertical or
horizontal axis.

Tweak is VideoWorks' Incremental Motion Generator, and is
used to create precise increments of motion from one frame to
the next. To use Tweak, click the pointer somewhere inside th—
large rectangle on the left hand side of the window and drag it

in the same direction and for the same distance as you want th~
castmember to move. When the mouse button is released, the
resultant vector is stored in memory, awaiting the command to--
implement it. To move the castmember, simply click the "Do It
button. The change from the x,y coordinates of the previous _
castmember is recorded in the two upper right hand boxes in

the window. Note that Tweak works only on the selected
castmember.

Command Key: Command 6

E0E Tweok ==

18 X - coordinate =
| =18 y- coordinate
%

Monitor is another way of looking at the Stage. It allows the —
Stage to be a resizable, scrollable and relocatable window.

o

Command Key: Command 7
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The Draw Menu is used in conjunction with the Line, Brush,
Rectangle, and Circle in CheapPaint (see above) and the
corresponding Quick-Draw Primitives in the Cast (see above.)
The top part of the menu defines the thickness of the lines
created by the Line Maker, while the bottom part of the menu
defines the fill pattern for the Rectangle and Circle.
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The FONT and The STYLE Menus

Chicago
vGeneva Bold
New York /telic
Monaco Underline
Cairo Dotiine
- | Bhadomw

0 peint
v(10 peind
12 pelnt
14 pelnt
18 pelnt

24 pelmd
36 point

The Font and Style menus are used only in conjunction with
Text in CheapPaint (see above) and define the fonts and other
characteristics of the text. The Font and Style menus are
identical to the corresponding menus in MacWrite and MacPaint.
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The EFX Menu

) G

vErase
No Erase

vCopy
or
Hor
Bic
NotCopy
Notor
NotHor
NotBic
Matte

The Efx (for "Special Effects™) Menu covers all the ways two
images can interact when their paths cross on the screen. In
the Copy mode (the default mode), for example, the resulting
image when a foreground (figure) sprite crosses in front of a
background (ground) is that of the foreground sprite itself.
Thus, if a black figure crosses in front of a white ground, the
resulting image will be black, while if a white figure crosses
in front of a black ground, the resulting image will be white,
and so on. These possibilities are best described in terms of
"truth tables”, tables which set out every possible value for
figure and ground with the corresponding result for each
combination.

Run the Efx Demo in the Tutorial Folder on the VideoWorks
disk for an animated demonstration of the truth tables.
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Copy -- the resulting image has the same value as the
foreground sprite itself. This corresponds to our perception of
an opaque object passing in front of another object. Copy
conforms to the following truth table:

Back- Fore-

Ground Ground Result
Black Black Black
Black White White
White Black Black
White White White

Or -- if either the foreground or background is black, then the

resulting image is black. In other words, the resulting image

is white only if both figure and ground are white. Or conforms
to the following truth table:

Back- Fore-

Ground Ground Result
Black Black Black

Black White Black

White Black Black

White White White
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Xor -- the resulting image is white if foreground and

background have the same value (i.e., both are black, or both are
white), and black if figure and ground have different values.

Xor conforms to the following truth table:

Back- Fore-

Ground Ground Besult
Black Black White

Black White Black

White Black Black

White White White

Bic -- the resulting image is white if foreground and

background have the same value; if figure and ground are
different, the resulting image has the same value as the ground.
Bic stands for "black is clear". Bic conforms to the following
truth table:

It's still there.

Back- Fore-

Ground Ground Result
Black Black White

Black White Black

White Black White

White White White
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NotCopy, NotOr, NotXor, NotBic are variations of the above  __
in which the figure is inverted (i.e., black is shown as white,

and white as black), similar to the Invert function in MacPaint.
The "Not" modes are otherwise identical to the above modes,

and the same truth table values apply.

No Erase leaves a trail of its previous locations as the image
moves across the screen. No Erase can be selected in
combination with the other Efx modes to create different types

of trails.

Matte forms a matte around the image, so that as it passes in ~ —
front of the background it is not bordered by a blank “frame”.
Because Matte will tend to slow down the animation, itis a =
good idea to use mattes sparingly, only in situations where one
object is passing in front of another. e

The SEX Menu -

Basic
Explosions
Weapons
Instruments
Nature
Space

0ld Music | 5
New Music

Business M

The Sfx (for "sound effects”) Menu contains a selection of
different sounds to add to your animations. Soundtracks are
added by selecting the frames in the Sound Channel of the Score —
(see above) which will carry the sound (by dragging the pointer
across them), and choosing the appropriate sound from the Sfx —
Menu. The Sfx Menu consists of a main menu made up of eight
submenus. Selecting any of the main menu categories will -
display a menu of sounds within that category. Simply select

the sound you wish to use from that submenu. o
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Top...
Neut... Nent... Next...
Bird1 Alarm Bach 1
Bird2 Mech Bach 2
Rivet Laser Mozart
Meow Fade Inl Spring
Bubblel Fade In2 Pastoral
Bubble2 Control Room Charmer

Electric

Dronel

Drone2
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Top... Top...
Next... Nexrt...
Shave Introl
Walk the Dog Intro2
Baligame Intro3
Cartoon I'm Here
Rockl Mini Fanfare
Rock2 Bad Times
Boogie Woogie Ending
Jazz Transition 1
Funk1 Transition 2
Funk?2 Transition 3
T Transition 4
Transition 5
Transition 6

There are 2 types of sound effects used in VideoWorks. The
most common is a sound, like an explosion or melody line, that
is started and continues on until it is over, whether it takes

1/2 second or 20 seconds. This type of sound needs to have at
least as many frames assigned to it in the Score as it takes for
the sound to play out. For a short sound this may be only 1 or 2
frames. But for a longer sound, like a melody, this may take 15,
20 or even 100 frames.

The second type of sound effect in VideoWorks connects
animation with sound. This is called synergistic interfacing, in
which the position of the sprite on the screen affects the pitch
or tone quality of the sound.

To connect a moving sprite with a sound, Copy that animation
sequence and Paste it into the sound channel at the same
frame positions. Then select this same section and select
Y-Synthesis from the Basic menu. As the sprite moves
toward the top of the Stage, you'll hear the pitch increase along
with it.
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The YX-Synthesis changes the volume of the sound as the
sprite moves along the horizontal axis. As the sprite moves
toward the right of the Stage, the volume will increase with it.

In addition, all of the melody lines in the Old Music, New Music
and Business submenus can be synergistically.

VIDEOWORKS
MEMORY ALLOCATION

VideoWorks dynamically allocates the Macintosh's memory. If
you have 10 large sprites on the Stage at once, then there is not
as much room in memory for a very long animation as there
would be for small to average sized sprites. There is a

tradeoff. You can have 2 or 3 sprites go on for a very long time,
or 24 sprites for not as long.

If you do run out of memory, VideoWorks let you know with a
Dialog box. Generally speaking the change, or edit, that
resulted in the Dialog box will not take affect and will not
harm your animation.

105






GLOSSARY

Activate

To specify which Window (or other item) will receive the next
command or set of commands. (see also Select)

Animation

A series of static images which, when presented in rapid
succession, create the illusion of movement. The images can be
recorded in analog form on a filmstrip, or digitally on a floppy
disk.

Castmember

A single image, one of the elements of a VideoWorks
Animation. A series of different Castmembers presented in
rapid succession can create the illusion of an image changing

shape.
Channel

The residence of a single Sprite in the Score.
Computer Animation

A form of Animation which uses high-speed manipulation of
binary information to create images on a cathode ray tube.

Foreground Prioritization

A method of defining which of two intersecting Sprites will
pass in front of the other. VideoWorks uses rank in the Score
to determine which Sprite will be foreground and which will

A feature of Computer Animation which simplifies the
animator's task by filling in the Frames between the beginning
point and the end point of an Animation sequence.
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Pixel

Shorthand for Picture Element, a Pixel represents the smallest
component part of a screen image. o

Real-Time -

A method of Computer Animation used by VideoWorks in
which the animated sequence is recorded as it takes place, so
that the original and the recorded sequences are the same, both

temporally and spatially.

Score .
A VideoWorks Window consisting of 24 video Channels and —
one soundtrack, and containing all the information about the
current animation sequence in one convenient place. —

Select —
To specify which item on the screen will be subject to the next _
command. For example, a selected Sprite, Castmember or
Channel is ready to receive the next command, such as Copy,

Cut, Paste or Clear. (See also Activate) [

Sprite i
A series of Castmembers which have been linked together g
within a single Channel to produce an animated sequence.

Synergistic

Interface ==
The connection between animation movement on the stage and __
the pitch of the sound.

Tweak e

VideoWorks' Incremental Motion Generator, Tweak lets the user
specify the distance (measured in Pixels) and the direction of
movement of a Castmember from one Frame to another. ple
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Vector

A quantity that has both direction and magnitude, usually
represented by a straight line. VideoWorks' Tweak function
defines the distance and direction of movement of a
Castmember in terms of a Vector represented by a straight
line.
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MISCELLANEOUS
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PERSPECTIVE
Add in details on largest “"object”™ and then shrink them to fit each consecutive
ob ject. Animating through the sequence will give the illusion of the object
meving towards and away from the viewer. Moving the shadow propertionately
T closer or father from the object determines the distance between it and the ground.

The crosshair under number represents vanishing peint.and should not be saved off
with the pattern but it should be used as a “registration pin™ in order to yeild
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ROBOTS
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Flip Horizontal - to make folding robot turn in opposite direction.

Matte arms over body while in Videoworks.
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Be sure to match up the location of the foot that the weight of the figure is en between
pattern switches in order to avoid the appearance that the figure is skating rather than

WALK, FEMALE

walking,

HM3F BS



HHHHHHHHH

RiTRI

11ELLEA LIS

* EMHHHH
ARRAHUIAIA

it § R E R

555555

DUUTYERRY







BIOGRAPHIES

Marc Aaron
Canter

Born on the South Side of Chicago in 1957, on the day that
Humphrey Bogart died, Marc Aaron Canter has had extensive
experience in performing, composing, fixing and selling. He
drove a cab and waited on tables in New York while in college.
With a name like Canter, it is not surprising that Marc has been
singing since a young age. His strong voice is especially
helpful at crowded trade shows, when he can float his baritone
over the roar of the hardware and the hucksters.

Efforts to bring together visual and musical people has brought
Marc back into the entertainment business. Hopes and dreams
for the future involve creating a new type of art, that defies
category and definition, but definitely "rocks the house!"

"“There are many tools necessary for creating good art and
animation. VideoWorks is the second, in a long line of products
from MacroMind, that will help solve the artists dilemma of
finding the right tools for the job."

Jay Fenton

Jay Fenton wrote his first game program, a roulette game,
during algebra class in 1969. He has since firmly believed that
computers are first and foremost toys. Jay produced his first
animation program in 1971 on the DEC PDP 8 using an
oscilloscope. College for Jay was a lengthy party interrupted
by numerous A.l. and graphics projects.

After a stint working for the Wisconsin State Government, he
entered the embryonic video game /pinball industry, and has
been a kingpin in the numbers racket ever since.

Jay likes programming on the Mac, because he does not have to
kill billions of aliens in order to show his audience a good time.
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Mark Stephen
Pierce

As a child Mark drew, watched a lot of T.V. and got "D"s and "F"s
in citizenship. For "higher" education he attended the School of
the Art Institute of Chicago where he drew, did some
performances with 100 T.V.s and 100 guitars, and got kicked
out of electronic music class.

In 1981 during his last year of his B.F.A. and still in pursuit of
the glowing essence of the C.R.T., Mark created his first
digitally animated face and was subsequently pulled into the
then pubescent video game/pinball industry. Last year he sold
his T.V. and bought a Mac. In the past 14 months while drawing
and animating on the Mac, Mark completely wore the feet off
his mouse and created over 5 megabytes of MacPaint
documents. During his career in the videogame industry he has
come into contact with a number of animation tools and is
currently convinced that VideoWorks is the best. Mark now
draws every day, sits in front of his Mac and is still trying to
improve his citizenship grades.

Dan Sadowski

Within his electronic cottage in Oak Park, on the western
reaches of Chicago, Dan develops graphic software on the
Macintosh for MacroMind, Inc. He didn't always do this. In fact,
before MacroMind existed, when he was not transporting yachts
up and down the eastern seaboard from Canada to the Caribbean,
or along the Erie Canal, Dan was busy acquiring his B.S. and M.S.
degrees at the University of lllinois - Chicago. Along the way,
Dan married a fellow computer graphics addict, Patti Harrison,
gave up the sea and has spent the last three years consulting in
the computer graphics field. When not programming or
bicycling, Dan and the little Ms. spend their time creating and
maintaining the next generation of software engineers.
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CREDITS

Program Design: Marc Canter, Jay Fenton, and Mark
Pierce
Programming: Jay Fenton and Dan Sadowski
Art & Animation: Mark Pierce
(Apeing Around by Mike Saenz)
Sound: David Theil and Marc Canter
Documentation: Nicholas Lavroff
Tutorial Design: Mark Pierce
Editing & Layout: Alan Jacobs
Quick-Start Card: Gail Rothenberg
Package Design: Robert Fernandez and Joan Powers

Project Management: Alan Jacobs and Gail Rothenberg

Nicholas Lavroff is a practicing attorney and writer in San
Francisco. His work has appeared in various computer
magazines, most notably Bay Area Computer Currents and
MACWORLD, with whom he is a contributing editor.

MacroMind, Inc. is represented exclusively by the William
Morris Agency and Ned Leavitt

Special thanks to:

Devorah Samet Canter, Lisa Conrad, Cathy Sharko, Bruce

Twickler, John Diamond, Larry Lewis, Leon Samet, William P.
Traylor, Jeanne O'Day, Walt Disney and Eadweard Muybridge.

Look for other Hayden Software products by MacroMind:
MusicWorks™ and Art Grabber™ with Body Shop™
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